Pacesetter Simply
Appliqué
Instruction Manual

ii

Pacesetter Simply Appliqué
Instruction Manual

Copyright
© Copyright 2015 Pulse Microsystems Ltd. All rights reserved.
This instruction manual and software are copyrighted by the
developer of the software, Pulse Microsystems Ltd. All rights
reserved. US Patent Nos. 5 270 939; 5 343 401; 5 430 658; 5 506
784; 5 510 994; 5 541 847; 5 668 730; 5 771 173; 5 809 921; 6
196 146; 6 216 618; 6 390 005; 6 968 255. European Patent Nos.
0545773. Other patents pending.
Information in this document is subject to change without notice.
The software described in this document is furnished under a
license agreement and/or nondisclosure agreement. The
software may be used or copied only in accordance with the
terms of those agreements. No part of this publication and the
software may be copied, photocopied, reproduced, translated, or
reduced to any electronic medium or machine-readable form
without the manufacturer’s written permission.
Commercial or industrial use of trademark and copyrighted works
(For example, books, paintings, drawings, photos, fanciful
characters, and so forth) owned by other companies or persons,
for creation of embroidery patterns without permission is illegal
and may result in either criminal or civil liability.
Microsoft®, Windows® 7, Windows® 8, and Windows® 10 are
registered trademarks of Microsoft Corporation. All other product
names are copyrighted and registered trademarks or trademarks
of their respective holders. All computer and software names
identified by TM or tm are trademarks of their respective
manufacturers.

Table of Contents
Learning about the Workspace ................................ 5
Parts of the Workspace ................................................................... 6
Title Bar .................................................................................... 6
Pacesetter Button ..................................................................... 7
Quick Access Toolbar ............................................................... 8
Toolbar and Ribbon Buttons .......................................................... 13
Pacesetter Menu Tools ........................................................... 13
Ribbon Tools........................................................................... 15
The View Tab.......................................................................... 18
Simulator ................................................................................ 19
Status Line.............................................................................. 21
Color Palette........................................................................... 21
Correcting Mistakes................................................................ 21
Using Scrollbars ..................................................................... 22
Setting up your Workspace............................................................ 23
Format Properties................................................................... 23
Environment Settings ............................................................. 24
Defining Grid Settings ............................................................ 25
Adjusting the View of the Workspace ............................................ 27
Magnifying and Reducing the View ........................................ 27
Hiding Panels Automatically ................................................... 28
Viewing Different Parts of the Workspace (Panning).............. 28
Changing the Background of the Workspace ......................... 29
Taking Measurements.................................................................... 31
Displaying the Hoop ...................................................................... 32
Viewing and Hiding the Hoop ................................................. 32
Selecting a Hoop .................................................................... 33
Creating a Custom Hoop ........................................................ 34

Creating & Editing Appliqué Designs .................... 35
Creating New Designs ................................................................... 36
Opening and Closing Designs ....................................................... 37
Setting Format Preferences........................................................... 38
Choosing the Default Recipe.................................................. 39
Choosing the Default Machine Format ................................... 42
Setting the Hoop Bracket Location ......................................... 42
Saving a Design ............................................................................ 43
Adding Designs ............................................................................. 44

2

Pacesetter Simply Appliqué
Instruction Manual

Appliqué Properties ....................................................................... 46
Appliqué Border Settings........................................................ 46
Tackdown Offset ..................................................................... 49
Placement Offset .................................................................... 50
Fabric Backgrounds in Appliqués ........................................... 51
Using ScanNCut ............................................................................ 53
Merging Design Files ..................................................................... 56
Selecting and Moving Objects in a Design .................................... 58
The Select Tool....................................................................... 58
Copying, Cutting, and Pasting Design Components .............. 61
Using the Alignment Tools ...................................................... 62
Moving Parts of a Design Manually ........................................ 64
Resizing Segments................................................................. 64
Nudging Segments ................................................................. 65
Deleting Segments ................................................................. 66
Rotating a Segment................................................................ 66
Removing Overlapped Appliqué Stitches ............................... 67
Working with the Color Palette ...................................................... 69
Selecting a Thread Chart ....................................................... 69
Searching for a Specific Color ................................................ 70
Changing a Thread Color ....................................................... 70
Garment Templates ....................................................................... 71
Using the Line and Shape Tools .................................................... 74
Drawing Lines......................................................................... 74
Editing Artwork with the Edit Shape Tool................................ 74
Converting to Appliqué .................................................................. 78
Printing Designs ............................................................................ 79
Previewing a Design before Printing ...................................... 79
Printing Design Worksheets ................................................... 80
Changing the Print Settings.................................................... 80

Creating Text & Editing Text Properties ................ 83
Creating Lettering .......................................................................... 84
Working with Text Frames ............................................................. 85
Adjusting Size of a Text Segment........................................... 85
Adjusting the Width of Text ..................................................... 86
Adjusting the Corners of Text Segments ................................ 86
Using the Envelope Handles .................................................. 87
Rotating Text........................................................................... 87
Adjusting the Slant of Text ...................................................... 88
Reset Frame........................................................................... 88

3

Working with Individual Letters ...................................................... 89
Adjusting the Space between Letters (Kerning) ..................... 90
Moving Individual Letters........................................................ 90
Resizing Individual Letters...................................................... 91
Rotating Individual Letters ...................................................... 91
Working with Color......................................................................... 92
Changing the Color of a Text Segment................................... 92
Changing the Color of Letters - Normal Embroidery .............. 93
Changing the Color of Letters - Appliqué Lettering ................ 94
Creating Multi-color Text for Regular Embroidery Fonts ........ 96
Auto-inserting Color Changes into Text .................................. 98
Adjusting Text Properties ............................................................. 100
Changing the Text ................................................................ 101
Changing the Font ................................................................ 101
Displaying a Font’s Available Characters ............................. 102
Adjusting the Height of Text.................................................. 103
Adjusting Letter Spacing....................................................... 103
Changing the Slant Setting................................................... 104
Adjusting Width Percentage ................................................. 105
Sew Sequence ..................................................................... 105
Setting the Connection Type ................................................ 105
Resetting the Text Frame ..................................................... 106
Appliqué Text Properties.............................................................. 107
Appliqué Border Settings...................................................... 107
Tackdown Offset ....................................................................111
Fabric Backgrounds in Appliqué Style Text .......................... 112
Adjusting Fill Settings .................................................................. 114
Choosing a Fill Pattern ......................................................... 115
Fill Density Setting................................................................ 116
Carved Fill Properties ........................................................... 117
Underlay Properties ..................................................................... 118
Selecting the Underlay Type ................................................ 118
Setting the Underlay Density ................................................ 119
Setting the Underlay Stitch Length ....................................... 119
Changing the Inset Distance ................................................ 120
Pull Compensation Settings......................................................... 120

Index ....................................................................... 123

4

Pacesetter Simply Appliqué
Instruction Manual

CHAPTER 1:

Learning about the
Workspace
Before you start using the software, we recommend that you
understand the Pacesetter Simply Appliqué design workspace
and learn a few of the basic components outlined in this section.
Topics covered in this chapter:
• Setting up the design workspace environment
• Showing a hoop in the workspace, and choosing the size of
hoop to be displayed
• Creating your own customized hoop
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Parts of the Workspace
The Pacesetter Simply Appliqué workspace contains a number of
different areas which have distinct functions. The sections that
follow give an overview of what each of these areas does, and
the kinds of information about the design that they contain.

Title Bar
The Title Bar appears at the top of the Pacesetter Simply
Appliqué design window. The Title bar displays information about
the design that is open in the workspace: its name, the number of
stitches and colors in the design, and the overall width and
height.

Learning about the Workspace

Pacesetter Button
At the top left-hand corner of the window is the Pacesetter
button. Clicking on the Pacesetter button gives you access to a
menu of useful tools, such as New, Save, Print, and several
others. For a complete list of the tools available on this menu,
and a summary of their functions, see “Pacesetter Menu Tools” in
the next section.
When you open the Pacesetter Menu, you will also see displayed
a list of recent files that you have been using. Just double-click
on the file name to open it.

Tools available on the Pacesetter Menu.

7
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Quick Access Toolbar
The Quick Access Toolbar is located right along the top of your
workspace, to the left of the Title Bar. This toolbar contains tool
buttons that you will commonly use, such as Open, Save, and
Print; but it is fully customizable, meaning that you can add the
tools you personally use most often, for easy access. See
“Customizing the Quick Access Toolbar.”
The following default tools are on the Quick Access Toolbar:
New, Open, Save, Direct Print, Undo and Redo.

Customizing the Quick Access Toolbar
One important advantage of the Quick Access Toolbar is that it is
fully customizable. This means that you are able to select tools
from any of the Pacesetter Simply Appliqué toolbars and add
them to the Quick Access Toolbar. You do this by way of the
Customize function, which is accessed by clicking the small
down arrow to the right of the Quick Access Toolbar.

To customize the Quick Access Toolbar:
1

Click the down arrow at the right end of the Quick Access
Toolbar.
You see a menu.

2

Click on More Commands...
You see the Customize dialog.

Learning about the Workspace

3

From the “Choose commands from:” list, select the toolbar
containing the command you want.
The list of tools on that toolbar now appears in the
“Commands” box.

4

Select the desired tool from within the “Commands” box, and
click Add.
The selected tool appears in the list of Quick Access Toolbar
tools.

5

Repeat steps 3-4 until you have added all the tools you want
to the Quick Access Toolbar.
If there is a tool on the Quick Access Toolbar that you do not
want to have on there, select it in the right-hand box and click
on the Remove button in the dialog.
When you have added and/or removed all the buttons you
want, click OK.
The dialog will close; the Quick Access Toolbar will be
changed accordingly.

6
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Adding Separators in the Quick Access
Toolbar
You have the option of also adding separators in the Quick
Access Toolbar. These are small vertical marks which appear on
the Quick Access Toolbar, and divide the commands into groups
for ease of use. A separator is added just the same way as you
add commands; select <separator> in the “Commands” list and
then click the Add >> button.
Here is an example of how the separators work: If you create an
arrangement of separators and commands in the Customize
dialog that looks like this:

The Quick Access Toolbar will be organized to look like this:

For more details, see the procedure outlined above,
“Customizing the Quick Access Toolbar.
You can change the position of a separator, or any command in
the Quick Access Toolbar. Select it in the box to the right in the
Customize dialog, and click the up and down arrows on the
right. This will move the command or separator relative to the
other commands in the Quick Access Toolbar.
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Customizing Keyboard Shortcuts
Another useful feature of the More Commands menu item (on the
Quick Access Toolbar) is that it gives you the option of assigning
your own custom keyboard shortcuts. Keyboard shortcuts can be
very useful for those tools that you use most often.

To assign keyboard shortcuts:
1

Click the down arrow at the right end of the Quick Access
Toolbar.
You see a menu.

2

Click on More Commands...
You see the Customize dialog.

3

Click the Keyboard button.
You see the Customize Keyboard dialog.
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4

From the “Categories” list, select the category containing the
command you want.
The corresponding list of commands appears in the
“Commands” box.

5

Select a command to which you would like to assign a
shortcut.
Click in the “Press new shortcut key” field.
On your keyboard, press the sequence of keys that you want
to use; these keystrokes will appear in the field.

6
7

If there are two or more keys used in the shortcut, a plus sign
(+) will be inserted between them, to indicate that they are to
be used in combination. The (+) on your keyboard is not part of
the shortcut sequence.

8

9

Click the Assign button to create the custom shortcut.
The shortcut sequence will be moved into the Current Keys
field.

Repeat steps 3 - 8 until you have created all the desired
keyboard shortcuts.
10 Click Close.

Learning about the Workspace 13

Toolbar and Ribbon Buttons
You can access the tools available in Pacesetter Simply
Appliqué through the Pacesetter button

and the various

toolbars. The tables below show the buttons, grouped by
location (i.e. whether they are on the Quick Access Bar, or one
of the tabs on the ribbon). A brief description of what the
button does is also included. Note that within each tab, some
buttons are grouped together by function.

Pacesetter Menu Tools
Tool

What it means
New: Creates a new untitled design.
New/Recipe: Opens the New Page dialog, which then allows
you to choose the recipe and machine format for the new
design.
Open: Opens an existing design file.
Merge: Opens the Merge Design dialog, which you can use
to import existing stitch or outline files into the current design.
Save: Saves the current design.
Save As: Opens the Save As dialog, allowing you to choose
the destination and file type to save it as.
Export Image: Creates an image file based on the current
design, which can be saved as a *.bmp, *.jpg, or *.png file.
Export SVG: Exports the current design as a vector graphic
image file.
Export FCM: Exports the current design as an *.FCM file,
which can be imported directly into a Brother ScanNCut
machine for appliqu é cutting.
Import FCM: Use to browse for existing *.FCM files and
import them directly into the workspace.
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Tool

What it means
Print: Opens the printer dialog on your computer, allowing
you to choose your printer and adjust the printer’s properties.
Direct Print: Prints a copy of the design worksheet,
bypassing the printer dialog.
Print Preview: Opens the print preview window, which in turn
will let you print the current design.
Print Setup: Opens the print setup dialog, which allows you
to select the printer, and to modify print properties.
Close: Closes the file that you are currently working on (the
active file) leaving any other files open.
Close All: Closes all files that are open on your computer.
Restore last autosaved: Opens the last file saved by the
Autosave feature. The frequency at which files are Autosaved
can be set on the Environment tab of the Preferences page;
the default setting is 5 minutes.
Exit: Closes all open files and shuts down Pacesetter Simply
Appliqué; you will be prompted to save any open files.

Extra Tools
Tool

What it means
Undo: Reverses your last action.
Redo: Reverses the action of the Undo command.
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Ribbon Tools
The Ribbon appears below the Title Bar. The Ribbon has four
tabs: the Home tab, the Arrange tab, the Tools tab, and the View
tab. Clicking on the tabs displays all the buttons for the functions
that are under that tab.

Tools on the Home Tab
Tool

What it means
Select: Selects objects in the design window.
Select All: Accessed via the drop-down menu from the
Select tool.Selects all items in the design workspace.
Cut: Cuts the selection and copies it to the clipboard.
Copy: Copies the selection to the clipboard.
Paste: Pastes the clipboard contents into the design, at
the end of the design sequence.
Insert: Pastes a copy of the clipboard selection into the
sewing sequence immediately following the selected
segment.
Delete: Removes the selected segment.
Text: Creates lettering placed along a straight baseline.
Add Design: Use to quickly add accent designs, appliqué
shapes, and split designs to the active design.
3D: Realistically renders your design onscreen.
Grid: Displays a background grid, which helps with
alignment. This grid can be used for the alignment of
items on the display.
Hoop: Displays the hoop as it fits relative to the
embroidery. Clicking this button a second time will turn
the view of the hoop off.
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Tool

What it means
Select Hoop: Accessed via the drop-down menu from
the Hoop tool. Opens up the Select Hoop window, in
which you can choose a new hoop.
Fit Hoop: Accessed via the drop-down menu from the
Hoop tool. Scales the design to so that it fits the current
hoop.
Background: Two options are available from this button,
Select Color or Select Fabric. Depending on which one
you choose, a dialog box will open in which you select
either the color, or the fabric pattern, that appears in the
background of the active design window.
Garment Templates: Opens the Garment Templates
dialog – use this dialog to insert a garment image into the
the design to preview design against the selected color or
fabric background.
Ruler: Measures the distance between any two points in
a design.
Zoom: Magnifies the design to fit a rectangle drawn by
the user with the mouse pointer.
Zoom in: Magnifies the view of the design by a fixed
amount.
Zoom out: Shrinks the view of the design by a fixed
amount.
Fit to Window: Displays the entire design and loaded
images in the window.
Back to 1:1: Returns design to original size.
Slider: Drag the slider to choose a specific level of
magnification; displays percentage of original size.
Pan: Allows you to move the design around in the
workspace window by clicking and dragging.
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Tools on the Arrange Tab
Tool

What it means
Align Left: Aligns all selected objects with the left-most item
selected.
Align Right: Aligns all selected objects with the right-most
item selected.
Align Top: Aligns all selected objects with the top-most item
selected.
Align Bottom: Aligns all selected objects with the bottommost item selected.
Horizontal Center: Takes all selected objects and centers
them in the selection box. The objects are moved so that they
are centered left-to-right with each other, but they are not
moved up or down.
Vertical Center: Centers all selected objects in the frame.
The objects are moved so that they are centered top-tobottom with each other, but they are not moved left or right.
Center: Centers one or more selected objects proportionally
within the current hoop. If more than one object is selected,
the entire group is moved together to the center of the hoop;
the objects selected remain in the same position relative to
each other as they had before being centered.
Flip Horizontal: Flips one or more selected objects
horizontally.
Flip Vertical: Flips one or more selected objects vertically.
Rotate Left: Rotates one or more selected objects to the left
by 90 degree increments.
Rotate Right: Rotates one or more selected objects to the
right by 90 degree increments.
Rotate Angle: Opens the Rotation dialog, which allows you
to enter the exact number of degrees of rotation to apply to
the selection.
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Tools on the Tools Tab
Tools

What it means
ScanNCut: Generates a printed template, or a digital file for
cutting, which you can use to scan into a cutting machine for
creating appliqués.
Page Preview: Places dotted outlines on the screen in shape
& size of the default page size. Assists in preparing Scan &
Cut image files for printing.
Page Preview Offset: Sets the position of the upper-left
corner of the page preview.
Line: Used to draw an artwork line into a design; allows you
to toggle between entering straight and curved points
Close Shape: Allows you to close open shapes when
working with the Line tool.
Edit Shape: Selects a line, and allows you to add, delete, or
move its anchor points
Convert to Appliqué: Converts the selected outline segment
to an appliqué segment.

The View Tab
The controls on the View tab allow you to change what appears
on your workspace; which panels are displayed, whether or not
commands and stitch points are shown in the design, and so on.
The areas found on this tab are Windows, Show/Hide, and
Program Preferences.

Windows
In the windows area, check the box to show the corresponding
window or panel, and uncheck it to hide that window or panel.
•

Sequence: Shows/hides the Sequence view.

•

Palette: Shows/hides the thread palette.
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•

Properties: Shows/hides the properties panel.

•

Simulator: Shows/hides the sewing simulator.

•

Status: Shows/hides the status bar.

Program Preferences
Click on the Program Preferences

button to open a dialog in

which you can set the default machine settings, change the units
of measure, and choose settings for the workspace grid.
For more information on this dialog, see “Setting up your
Workspace Environment.”

Simulator
The Simulator makes it easy to see on-screen how your design
will sew out. You can use the Simulator to eliminate potential
sewing problems.
When you select Simulator from the View tab of the Ribbon, the
Simulator (scrollbar slider and the sewing simulator) will appear
at the bottom of the design space. The Simulator controls which
parts of the design are drawn in the design window.
You can also open and close the Simulator by pressing Ctrl + R.

Scrollbar Slider

The length of the scrollbar slider represents all of the stitches in
the opened design. You can move the scrollbar slider by dragging
it to see a design as it will look sewn to a particular point. The
color display within the scrollbar indicates the thread color that
will be sewn when the scrollbar slider is positioned over it.
Clicking on the arrows at the ends of the scrollbar will advance or
retrace the design position by one stitch.
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Sewing Simulator

The sewing simulator allows you to watch your design draw on a
stitch-by-stitch basis, simulating the sewing action of your
machine. The Simulator controls include pause, stop, sew
forward and sew backwards. You can push various control
buttons and slide the speed control to vary the rate of sewing.

Using the Simulator
The following table explains how to use the Simulator in more
detail:
Tools

What it does
Previous Stitch: Move backward in the design by
one stitch.
Scrollbar slider: Drag the scrollbar slider to
advance the design to a specific position. When
the scroll bar slider is positioned over a color, you
will see the specified thread color being sewn in
the design. The entire length of the scrollbar slider
represents the entire design.
Next Stitch: Move forward in the design by one
stitch.
Simulate Sewing (backward): Move backward
through the design.
Pause/Stop: Pause or stop the design while
drawing. When you play or resume sewing your
design, stitching will continue from the location of
the last stitch.
Simulate Sewing: Move forward through the
design.
Speed: Slide the speed control to vary the rate of
sewing.

Learning about the Workspace 21

Status Line
The Status Line appears at the bottom of the Pacesetter Simply
Appliqué window. To show or hide the Status Line, go to the
Windows area of the View Tab and check or uncheck Status.
As you move the mouse over different sections of the workspace,
this indicator will tell you what that area or button does. You will
also find specific design information in other areas of the status
bar; it shows the total number of segments in the design, the
number of segments currently selected, the machine format, the
recipe used by the current design, the number of stitches in the
selected design components and the hoop being used.

Color Palette
The thread colors for the design are shown in the Color Palette
located along the top edge of the workspace. To show the Color
Palette (if it is not already displayed), go to the Windows area of
the View tab and check the Palette box.

For more information on the color palette, see “Changing Thread
Colors.”

Correcting Mistakes
Undo and Redo are two significant features that allow you to
correct mistakes. If you make a mistake and change your mind
about an action you just made, Undo reverses the action. Redo
puts back the change. If Undo or Redo are grayed out, you
cannot Undo or Redo.

To use Undo:
•

Do one of the following:


On the Quick Access Toolbar click the Undo



Press Ctrl+Z on your keyboard.

tool.
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To use Redo:
•

Do one of the following:


From the Quick Access Toolbar, click the Redo



Press Ctrl+Y on your keyboard.

tool.

Using Scrollbars
Scrollbars are tools in the workspace that enable you to move
easily around within the displayed design. There are two
scrollbars, one for moving the view vertically, and one for moving
it horizontally.

How to use the scrollbars:
•

To pan left/right or up/down, click and drag the track button.

•

Click on the small arrows at each end of the scrollbar to move
the design view incrementally.

•

Click in the track of the scrollbar to move the workspace view
by one whole screen.

You can also right-click the scrollbar to display a pop-up menu of
scroll actions. The menu displays the following options,
depending on whether you click in the vertical scrollbar or the
horizontal scrollbar:

Vertical Scrollbar Options

Horizontal Scrollbar Options
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Setting up your Workspace
Certain properties of the Pacesetter software - such as the grid
spacing, or how designs are handled - can be configured in on
the Preferences dialog. Open this dialog by clicking the Program
Preferences

button on the View tab.

There are several different categories of preferences on this
dialog – Format, Environment, and Grid. The settings in each
category will be treated separately in the following sections.

Format Properties
All designs in Pacesetter Simply Appliqué have a machine
format. Machine formats have their own profile settings that
determine how embroidery information will be interpreted when
you save design files. When you create a new design file, you
can select the machine format for the specific design.
The selected machine format can change how the design file is
read. When you set machine format properties in the Preferences
dialog, all new designs will use these machine format properties
as the default settings.
If you open a design with the New/Recipe command, you can
select the recipe for the new design in the New Page dialog. This
will override whichever recipe is set as the default in the
Preferences dialog.
Changing machine format properties after a design file has been
opened will not change the machine format of the embroidery
designs in that design.

To adjust format properties:
1

On the View tab, select the Preferences

button.

2

Select the Formats tab; do one or more of the following:

You see the Program Preferences dialog box.


In the Recipe drop-down list, select which recipe will be
applied, by default, each time you open a new design.
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From the Machine format list, select the machine format
that you want applied to new design files.



3

Hoop Bracket Location: When the hoop preview is
displayed in the workspace, it will show which side the
bracket is on. This setting determines the bracket’s
location - top, bottom, left or right.
Click OK.
Your preferences will be changed accordingly, and the
Program Preferences dialog box will close.

Environment Settings
On the Environment tab, you set parameters that relate to
aspects of the workspace environment - the units of
measurement used and the Autosave frequency.
It also allows you to turn the “Show warning for large satins”
warning message on or off. This message will be displayed if,
during a rescaling of a satin column, any of the stitches get
longer than 10 mm.

To set up your workspace environment:
1

On the View tab, select the Preferences

button.

You see the Preferences dialog box.
2
3

On the Environment tab, select the units of measurement you
want used for your designs: Metric or English.
From the Autosave list, select how frequently you want the
open designs to be saved..
Autosave is a function that periodically saves the open design or
designs to disk, so that you will not lose all your edits in case of a
service interruption. If you do have such an interruption, you will
be able to restore the autosaved file by clicking the Restore
Autosaved tool on the Accelerator menu.

4

5

The “Show warning for large satins” box will be checked
(enabled) by default; uncheck the box to disable the warning
message.
Click OK.
Your preferences will be saved, and the dialog will close.
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Defining Grid Settings
The Grid Settings help you align and measure artwork and
design elements. You can set the grid to measure in millimeters
or inches according to your preference. You can show/hide the
grid by clicking the Grid icon on the Home tab.
By default, every horizontal and vertical line will be highlighted in
the major grid. If required, you can add more major grid lines as
well as a minor grid. You can also increase or decrease the spacing of the minor grid. The minor grid can also have different horizontal and vertical spacing values.
To make grid lines more visible on particular backgrounds, you
can change the color of the major and minor grids; separate
colors may be chosen for the major and minor grids.

To define grid settings:
1

To open the grid settings dialog, do one of the following:


Right-click on the rulers at the left or top of the window
and click Grid Settings.



On the View tab, click Preferences
Grid tab.
You see the Grid settings dialog.

and select the
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2

In the Grid Minor area, complete the following:


3

In the Horizontal spacing box, enter the measurements for
horizontal spacing in millimeters or inches.
 In the Vertical spacing box, enter the measurements for
vertical spacing in millimeters or inches.
 From the Color list, select a predefined color to use for the
minor grid. If you want to choose from a larger selection of
colors, click Custom from the color box.
In the Grid Major area, complete the following:


4

5

6

In the Horizontally every (lines) box, enter how often you
want horizontal lines to be highlighted in the major grid.
For example, if you enter 3 in this box, every third
horizontal line will be highlighted in the major grid.
 In the Vertically every (lines) box, enter how often you
want vertical lines to be highlighted in the major grid. For
example, if you enter 5 in this box, every fifth vertical line
will be highlighted in the major grid.
 From the Color list, select a predefined color to use for the
major grid. If you want to choose from a larger selection of
colors, click Custom from the color box.
In the Style area, select one of the following grid styles:
 Show grid as solid lines
 Show grid as dashed lines
 Show grid as dots
By default, the “Snap to Grid” option will be selected. This
means that any time you use the Line tool to draw a line, or
use the Edit Shape tool to move an anchor point, the point
will snap to the nearest grid line.
To disable this feature, uncheck the “Snap to Grid” check box.
Click OK.
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Adjusting the View of the
Workspace
Magnifying and Reducing the View
Use Zoom to magnify or reduce parts of your design. With Zoom
you can either left-click to enlarge your design or right-click to
make your design smaller. When you select Zoom, the cursor
changes to a small magnifying glass. To use the Zoom tool, do
one of the following:
•

To zoom in on the spot where the mouse is currently pointing,
left-click.

•

To zoom out again, right-click.

•

To zoom in on a particular area, left-click and drag; the
display will expand to show only the area that you have
dragged over.

To use the Zoom Tool:
1

On the Home tab, click on the Zoom

tool.

The pointer becomes a magnifying glass.
2

Do either of the following:



Left-click to make your design larger.
Right-click that area to make your design smaller.

To zoom-in on a specific area:
1

On the Home tab, click on the Zoom

tool.

2

Click and hold your mouse button and drag it to form a flexible
box around the area you want to see in detail.
Do one of the following steps:

The pointer becomes a magnifying glass.

3




To increase the zoom, continue clicking and dragging the
flexible box.
From the Zoom toolbar, click on the down arrow under the
Zoom icon, and use the Zoom tool settings to zoom back
out.
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Additional options on the Zoom Toolbar:
When you click on the down arrow underneath the Zoom Tool,
you will see an option menu. You can choose from any of the
following options on this menu:
•

Zoom In to make your design larger.

•

Zoom Out to make your design smaller.

•

To Fit to make the whole design the size of the design
window.

•

To Selection to zoom to the size of the currently selected
embroidery segment, or set of embroidery segments if more
than one is selected.

•

1:1 to see the design at the actual size.

Hiding Panels Automatically
To increase the amount of space for your design window, you can
set the Sequence and Properties panels to the Auto hide mode.
When Auto hide is on, the panel will only be visible while the
mouse is over it; as soon as you remove the mouse, the panel
will collapse to a narrow sidebar.
To turn on Auto hide for these panels, click on the small push-pin
icon

at the top-right of the panel. When the panel is in Auto

hide mode, the small push-pin will be on its side, like this:
.
Now, whenever you move the mouse to another part of the
screen, the panel will be hidden. To turn Auto hide off, click on
the

icon again.

Viewing Different Parts of the
Workspace (Panning)
Sometimes you may want to work at a high level of magnification,
and some part of the garment or embroidery you’re working on
will not show up in the workspace.You can move to parts of your
design that go beyond the window’s borders. In these situations,
you can use keyboard arrows or the pan tool to change your view
of the design.
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Panning using the keyboard:
•

Use the

key to move up.

•

Use the

key to move down.

•

Use the

key to move left.

•

Use the

key to move right.

Using the Pan Tool
Use the Pan

tool to move the view of the design around in

the workspace by clicking and dragging. While you are using the
Pan tool, you will still be able to see the design in the window.
Note that the Pan tool does not actually move parts of the design
around, just your view of them.
You can right-click to switch back to whichever tool you were
using before you selected the Pan tool.

Changing the Background of the
Workspace
Depending on the colors of the design you are creating, you may
want to change the background color of your window. For
example, if you are creating a design with light color threads, you
may want your background darker so that the stitches are more
visible on-screen.
It may also be helpful to see the design preview against a fabric
background; you can select a fabric background from one of the
images that come in the Pacesetter Simply Appliqué library of
fabric swatches, or load your own image to use as a fabric
background.
For information on how to import images of fabrics for use as a
backgrounds see “Appliqué Text Properties—Fabric
Backgrounds in Appliqué Style Text.”
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To change the color of the workspace background:
1

On the Home tab, select the Background

tool.

You see a menu.
2

On the menu, click Select Color.
You see the Color dialog.

3

Do one of the following:


4

Choose a color from one of the Basic colors on the left of
the dialog.
 Create a custom color by clicking in the color chooser
field on the right of the dialog.
 Create a specific color by entering its RGB values in the
corresponding fields.
Click OK.
The new color replaces the old color on your design window.
To remove the color from the workspace, select Background–
Select Color and choose white on the Color dialog.

To display a fabric background in the workspace:
1

On the Home tab, select the Background
You see a menu.

tool.
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2

On the menu, click Select Fabric.
You see the Load Fabric dialog.

3

Select one of the available fabric by clicking on its swatch.
You see a preview of the selected fabric on the right of the
dialog.

4

Click Open.
The image of the fabric appears as the background in the
design workspace.
To remove the color from the workspace, select Background–
Select Color and choose white on the Color dialog.

Taking Measurements
The Ruler

tool lets you measure the distance between any

two points in your design workspace. When you measure from
one point to another, the distance is displayed in the status line
located at the bottom of the window. The status line shows the
total length measured, the length in the horizontal (width) and
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vertical (height) directions, the angle of the line (compared to
horizontal).
The ruler measurements are calculated in the units you set
under the Units tab of the Preferences dialog.

To measure Designs:
1

On the Home tab, click on the Ruler

tool.

Your pointer changes to a ruler when in the Design
Workspace.
2
3

Click and drag your mouse until you are finished measuring
the item.
Let go of your mouse when you are finished measuring.
The measurement is now displayed in the status bar.

Displaying the Hoop
Viewing the hoop or frame on the screen lets you ensure that
your design fits properly when you run it on the machine. The
hoop serves as a guide to help size and position your design in
the design window. Pacesetter Simply Appliqué comes with many
pre-loaded hoop sizes.

Viewing and Hiding the Hoop
Use the Hoop

tool to show and hide the hoop in the display

window. Just click on the Hoop tool to show the hoop (if it is not
currently shown) and click it again to hide the hoop.
The hoop’s dimensions are set using the “Select Hoop” option
under the Show/Hide Hoop button. See the following section,
“Selecting the Hoop.”
Displaying the Hoop may affect the magnification level of your
design. For example, if you are zoomed in on the design,
displaying the Hoop will cause the view to zoom out enough to fit
the entire hoop into the workspace.
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Selecting a Hoop
You can select one of the pre-loaded hoops using the Hoops
dialog. You will notice that you can select hoops from different file
types in this dialog. This is useful when you want to make sure
that your design will fit for more than one kind of embroidery
machine.
To set the location of the hoop bracket, so that it corresponds to
the location of the bracket on your machine, go to the
Preferences dialog–Formats tab, and chose the correct location
from the list; the position of the hoop bracket in the workspace
will change accordingly. See “Format Properties”, page 23.

To select a hoop using the Hoops dialog:
1
2

On the Home Tab click the down arrow under the Hoop tool.
From the menu that appears, click on Select Hoop.
You see the Hoops dialog.

3

Select the machine format from the Format drop-down list.

4
5

From the list, choose a hoop size appropriate for your design.
If needed, check the “Rotate 90” box to make the hoop fit your
design better.
Click OK.

6
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Creating a Custom Hoop
You can also create your own custom-sized hoops using the
Hoops dialog. Once you have set the parameters for your hoop
and typed in a description, the custom hoop will be saved by the
Hoops dialog; it will be available for your use in future designs.

To add a custom hoop:
1
2

On the Home Tab click the down arrow under the Hoop tool.
From the menu that appears, click on Select Hoop.
You see the Hoops dialog.

3

Click the New button.
You see the New Hoop dialog.

4

Enter the dimensions for your new hoop in the Width and
Height boxes.
In the Name box, type a name for your custom hoop.
Click OK.
The new hoop’s name will now be displayed in the list of hoops
that you can select from in the Hoops dialog.

5
6

7
8

Click on the name; the new hoop’s dimensions now appear in
the Hoops dialog on the lower right of the dialog.
Click Apply.
The new hoop shows in your design location.

CHAPTER 2:

Creating & Editing
Appliqué Designs
With Pacesetter Simply Appliqué, you can place appliqué
designs within a file, and add embroidery accents. You can also
modify various properties of the design using the Properties
panel.
Topics covered in this chapter:
• Adding appliqués to a design using the Appliqué tool
• Adding embroidery accents with the Add Design tool
• Using the ScanNCut tool
• Editing individual segments – cutting, copying, pasting, and
moving components of a design
• Adjusting segment properties – for example, Fill type,
Underlay, and Pull compensation - in the Properties panel
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Creating New Designs
When you open Pacesetter Simply Appliqué, you can
immediately begin creating a new, untitled design in the design
window. The design window automatically opens using the
default recipe and machine format settings specified in the
Preferences dialog. For more information on default settings, see
“Setting up your Workspace Environment.”
If you want to open a design and apply a different recipe to it
(that is, not the default recipe), you will want to open using the
New/Recipe tool.

To create a new design using the recipe dialog:
1

Click the Pacesetter Button
Recipe

, and then click the New/

tool.

The New
tool bypasses the New Page dialog; in this case, a
new design window will open using the default recipe and
machine format settings.
For more information on setting these defaults, see “Choosing the
Default recipe.”

You see the New Page dialog.

2

In the Recipe list, select the recipe you want to use for your
design.
The Recipe description box in the dialog gives you a brief
description of each recipe as you scroll through the list in the
Recipe drop-down list.
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3
4

In the Machine format list, select the machine format that you
want applied to the design when created.
Click OK.
You see a new, blank design.

Opening and Closing Designs
Pacesetter Simply Appliqué allows you to open designs in a wide
variety of file formats. When you open a design file in the design
window, your single design file retains the stitches for that
design.

To open an existing design:
1

Do one of the following:


Click the Open



Click the Pacesetter Button

tool on the Quick Access Toolbar
and select Open from the

menu.
You see the Open Design dialog box.
2
3
4
5
6

In the Look in list, browse to the location of the file you want
to open.
In the Files of type list, select the format for the design you
want to open.
In the File name box, enter the file name, or select the file you
want to open by clicking the file.
Select Preview to view a thumbnail (a small representation) of
the design in the Open dialog.
(Optional) Check the Convert to Outlines box to convert a
stitch (i.e. non-*BRF) file to outlines.
If this option is selected, the design’s stitch segments will be
converted to outlines. Once a file has been converted, you
can save it as a *.BRF file.
Note that stitch files must be converted to outlines in order to
apply the “Remove overlapped stitches” function to them at any
point in the design process.
See “Creating & Editing Appliqué Designs—Removing
Overlapped Appliqué Stitches” for more information.
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7

Click Open.
To open a file you have recently worked on, click the Pacesetter
Button

and locate it in the “Recently used designs” list.

To close a design:
•

Click the Pacesetter Button
Close All

and select Close

or

from the menu.

Setting Format Preferences
Your overall, default Format preferences may be set on the
Preferences panel > Formats tab. This is where you will set the
default design recipe, machine format, and hoop bracket
location.

To open the Preferences dialog box:
•

On the Ribbon, select the View tab on the ribbon and click on
the Preferences button.
The Preferences dialog will open.

Creating & Editing Appliqué Designs 39

Choosing the Default Recipe
You choose one of the pre-installed recipes through the New
design dialog each time you open a new design. The NORMAL
recipe is the default for new designs; however, you can set the
default to a different recipe through the Preferences dialog box.
The recipe you choose then becomes the default for all subsequent design files that you open. The recipes containing fabric
settings are applied to all the lettering you create in that design.
You can also change the recipe (style) of a design, or part of a
design, after it has been created. With the Select tool active,
select part of the design (or, use Ctrl+A to select all of the design)
and then right-click; from the context menu that opens, choose
Apply Style, and then select the desired recipe from the list.

The tables on the following two pages show the settings
associated with each recipe, listed alphabetically by fabric type.

Satin Density (Default)

Fill Density (Default)

Pull-Compensation
(Absolute value)

Contour Underlay

Lattice Underlay

Full Lattice
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Fabric
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Baby Blankets

0.4

0.4

0.3

Yes

Yes

No

Canvas

0.4

0.4

0.4

Yes

No

Yes

Cap

0.4

0.4

0.2

No

No

No

Denim

0.4

0.4

0

No

No

No

Dog Collar

0.5

0.5

0.1

No

No

No

Fake Fur

0.4

0.4

0.3

Yes

Yes

No

Fleece

0.4

0.4

0.1

Yes

No

No

Jeans

0.4

0.4

0.2

Yes

Yes

No

Leather

0.6

0.6

0

No

No

No

Lycra

0.4

0.4

0.4

Yes

Yes

No

Normal

0.4

0.4

0

No

No

No

Pique

0.4

0.4

0.4

Yes

Yes

No

Satin

0.5

0.5

0.1

Yes

No

No

Shirt Cuff

0.4

0.4

0.2

No

No

No

Silk

0.5

0.5

0.1

Yes

No

No

Sweat Shirt

0.4

0.4

0.3

Yes

Yes

No

Towel

0.4

0.4

0.3

Yes

No

Yes

T-shirt

0.4

0.4

0.4

Yes

Yes

No

Velvet

0.4

0.4

0.4

Yes

Yes

No

Vinyl

0.6

0.6

0.1

No

No

No

Woven Fabrics

0.4

0.4

0.2

Yes

Yes

No

Parallel Underlay

Perpendicular Underlay

Underlay Inset Distance

Underlay Density

Underlay Stitch Length

Baby Blankets

No

Yes

No

0.3

2.5

2.5

Canvas

Yes

No

Yes

0.7

2

3.5

Cap

No

No

No

0.7

2

3.5

Denim

No

No

No

0.6

2

2.5

Dog Collar

No

No

No

0.7

2

3.5

Fake Fur

Yes

No

No

0.3

2.5

2.5

Fleece

No

No

No

0.5

2

2.5

Jeans

No

No

No

0.4

4

2.5

Leather

No

No

No

0.6

2

2.5

Lycra

Yes

No

No

0.3

3

2.5

Normal

No

No

No

0.6

2

2.5

Pique

Yes

No

No

0.3

2

2.5

Satin

No

No

No

0.4

2

2.5

Shirt Cuff

No

No

No

0.7

2

3.5

Silk

No

No

No

0.4

2

2.5

Sweat Shirt

No

No

No

0.3

2

2.5

Towel

Yes

No

Yes

0.4

2

2.5

T-shirt

No

No

No

0.3

2

2.5

Velvet

Yes

No

No

0.3

2.5

2.5

Vinyl

No

No

No

0.7

2

3.5

Woven Fabrics

No

No

No

0.4

4

2.5

Fabric

ZigZag Underlay
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Choosing the Default Machine Format
The default machine format is set on the Formats page of the
Preferences dialog. This is the format that will be applied
whenever you create a new design, except when otherwise
specified in the New Page dialog (see “Creating New Designs”).
•

To set the machine format, choose your preferred format from
the drop-down list.

Setting the Hoop Bracket Location
When the hoop is displayed in the workspace, it will show which
side the bracket is on. You can select the position of the bracket
on the hoop on the Preferences page.
•

Use the Hoop Bracket location drop-down list to set the
bracket’s location - top, bottom, left or right.
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Saving a Design
The Save As command lets you save an alternative version of
the design with a different name, location, or file format. Save As
is used when you want to keep your original design and create
another design with slight modifications. The Save command
saves the changes you make to the current design.

To save a design:
1

Do one of the following:


2
3
4
5

Click the Pacesetter Button
and choose Save As
from the menu
 On the Quick Access Toolbar, choose the Save As tool.
You see the Save As dialog box.
In the Save in list, browse to the location you want to save
your file.
In the File Name box, enter the file name for the design you
want to save.
In the Save As type list, select the file type you want the
design to be saved as.
Click Save.

To save changes to the current design:
•

Do one of the following


Click the Pacesetter Button

and choose Save

from the menu.


On the Quick Access Toolbar, click the Save

button.
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Adding Designs
Use the Add Design

feature to embellish your designs with

pre-digitized accents, appliques, or “split” designs.
When embroidery is imported using the Add Design tool, the
design will retain its own recipe, which may be different from the
one used for the design it is being imported into.
However, you can change the recipe of the imported design, if
necessary, by selecting it, right-clicking, and then selecting
Apply Style... from the context menu that appears.

To use the Add Design tool:
1

In the Home tab of the Ribbon, click on the Add Design
tool.
A pop-up window opens in front of the workspace, displaying
an array of thumbnails.

2

From the Folder drop-down list, choose one of the following
categories:



Accents
Appliqué Shapes.
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 Split Designs
The design thumbnails in the Add Design window change
according to your selection.
3

From the window, click on the design you want to import.
The Add Design window closes; your cursor changes to a
small cross, indicating that the Add Design tool is active.

4

Place the mouse pointer at the position you would like the
added design to be placed.
Click and drag the mouse; as you drag, note that the Add
Design appears in outline in your workspace. This outline
indicates the size and orientation of the Add Design
embroidery before it is actually generated in your design.

5

6

To finish placing the Add Design segment, release the mouse
button.
You can also insert a design quickly by just following steps 1-4
above, and then clicking in the workspace. This will add the
selected design at the default size.

7

To adjust the size and orientation of the Add Design segment
after it is placed, select it with the Select tool, and use the
handles to resize or rotate it.
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Appliqué Properties
You can change the properties of the Appliqué border in the
properties panel.
For Appliqué frames, there are two different categories of settings, generally speaking: those settings that are specific to the
type of border stitch you apply (for example, satin vs. blanket),
and those that apply to all types of appliqué (such as tackdown
offset, placement offset, and fabric fill). The latter types of properties are dealt with in their own separate sections, which follow.

Appliqué Border Settings
There are four different kinds of border stitches that can be
applied to appliqués: Satin, Blanket, Motif, and Run. Which
properties can be adjusted will depend to some extent on the
type of border stitch you choose.

Satin Properties
To adjust Satin properties:
1
2

Select the Appliqué design.
In the properties panel, do the following:


In the Stitch Length box, enter the stitch length of the
placement and tackdown runs.
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In the width field, enter a value for the width of the satin
appliqué border.



In the density field, enter a value for the stitch density
(value will be shown in mm).
In the Inset (%) field, enter the inset percentage value.
The Inset percentage setting determines the placement of
the satin border relative to the outline of the shape. A
value of 0% means that the satin will be just outside the
outline, while a value of 100% means it will be just inside
the outline.
By default, the inset is set at 50%, which places the
center of the satin over the outline.



Examples of Satin appliques with different inset percentages applied:
0% (left), 50% (middle) and 100% (right).

3

Click Apply.
Your changes will be applied to the selected design.

Blanket Properties
To adjust Blanket properties:
1
2

Select the Appliqué design.
In the properties panel, do the following:





In the Stitch Length box, enter the stitch length of the
placement and tackdown runs.
In the Width field, enter the width of the appliqué border;
this value determines the length of the perpendicular, or
‘blanket’, stitches.
In the Blanket density field, set the density of the blanket
stitches; this value determines how often the
perpendicular, or ‘blanket’ stitch will be sewn.
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3

Click Apply to save your changes.
The appliqué border stitches will be adjusted accordingly.

Motif Properties
To adjust Motif properties:
1
2

Select the Appliqué design.
In the properties panel, do the following:




From the Motif drop-down list, select a motif pattern to
apply to the appliqué border.
In the stitch length field, enter the value for the stitch
length.
In the Inset (%) field, enter the Inset percentage value.
The Inset percentage setting determines the placement of
the motif border relative to the outline of the shape. A
value of 0% means that the motif will be just outside the
outline, while a value of 100% means it will be just inside
the outline.
By default, the inset is set at 50%, which places the
middle of the motif over the outline.

Examples of Motif appliques with different inset percentages applied:
0% (left), 50% (middle) and 100% (right).

3

Click Apply.
The appliqué border stitches will be adjusted accordingly.

Run Stitch Properties
To adjust Run properties:
1

Select the Run Appliqué design.
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2

In the properties panel, do the following:


3

In the Run Type field, choose one of the following stitch
types: Single run, Double run or Bean.
 A Single Run stitch is a simple forward-moving stitch
that looks like any straight stitch produced by a sewing
machine.
 A Double Run stitch sews over the line twice: once
forward, and once backward, thus it ends up where it
starts.
 The Bean stitch (also known as Three-ply stitch) is a
running stitch where the machine sews over each
stitch three times (forward, back, forward again) before
it moves to the next stitch. The result is a heavy
running stitch.
 In the Stitch length field, input the stitch length (in mm).
Click Apply.
The appliqué border stitches will be adjusted accordingly.

Tackdown Offset
The Tackdown Offset property is applicable to all types of
appliqué borders.
By default, the tackdown stitches of an appliqué border will be
offset by -0.5mm - in other words, they will be sewn just inside
the digitized outline of the appliqué design. However, you can
use the Tackdown Offset property to shift the tackdown stitches
outwards (or inwards) from this outline by a distance you specify.
Enter a positive number to shift them outwards, or a negative
number to shift them inwards.
Note that the offset is always given in millimeters, even if the
ruler units have been set to measure in inches.

Setting the Tackdown offset distance:
1
2
3

Select the Appliqué text segment.
In the Appliqué area of the Properties panel, select the
Tackdown Offset field.
Enter the value for the offset (in mm).
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4

Click Apply.
The tackdown stitches will be adjusted accordingly.

Close-up of a blanket appliqué frame, with offsets applied. The placement
stitches (green) have been offset by +2.0 mm, and the tackdown stitches (red)
by -5.0 mm.

Placement Offset
The Placement Offset property is applicable to all types of
appliqué borders.
By default, the placement stitches of an appliqué border will be
offset by 0.0 mm - in other words, they will be sewn right along
the outline of the design. The Placement Offset property shifts
the placement stitches outwards (or inwards) from this outline by
the distance you specify. Enter a positive number to shift them
outwards, or a negative number to shift them inwards.
Note that the offset is always given in millimeters, even if the
ruler units have been set to measure in inches.

Setting the Placement offset distance:
1
2
3
4

Select the Appliqué text segment.
In the Appliqué area of the Properties panel, select the
Placement Offset field.
Enter the value for the offset (in mm).
Click Apply.
The placement stitches will be adjusted accordingly.
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Fabric Backgrounds in Appliqués
The Fabric Background Property is applicable to all types of
appliqué text.
You have the option of selecting a fabric background to display
within the appliqué border. You can select either from a list of
fabric images provided with Pacesetter Simply Appliqué, or
import your own image file to use as a background.

To display a fabric background in an Appliqué segment:
1
2
3

4

Select the Appliqué text segment.
In the Appliqué area of the Properties panel, select the Fabric
field.
In the Fabric field, click Select.
The Fabrics dialog pops up in front of the workspace.

Select a fabric from the dialog by clicking on its swatch.
If you want to use your own images for Appliqué backgrounds,
you can import them using the Add... button; see “Importing an
images to use as Appliqué Fabrics,” below.
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5

Click OK.
The selected fabric image appears within the Appliqué border.
To remove the fabric background from the appliqué, click the
Select button again to re-open the Fabric dialog. In the dialog,
select the “None” swatch, and then click OK to close it. In the
design, the background of the shape will be cleared.

Importing Images to use as Appliqué Fabrics
You can also use your own images for the Appliqué background.
This dialog permits you to import image files into the Appliqué
Fabrics folder on your computer. You can import files in the
following formats: *.bmp, *.jpg, *.tif, *.pcx *.pct or *.tga.

To import a an image file for an Appliqué Fabric fill:
1

On the Fabrics dialog, click Add...
You see the Import fabrics dialog.

2

In the Look in field, browse to the directory with the image file
that you want to import.
(Optional) Select the file type of the images you want import
from the Files of type drop-down list.
You see thumbnails images of the file type that has been
selected.

3

4

Select the thumbnail you want to add as a fabric background.
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5

Click Open.
The selected image will now be available in the list of Appliqué
Fabrics in the properties panel.

Using ScanNCut
The ScanNCut

tool is very useful in creating appliqués.

When applied to the selected appliqué, this tool generates a new
file, consisting of filled artwork segments. Each filled artwork
shape that it generates corresponds to an appliqué segment in
the original design. These files can be exported as SVG or FCM
files and opened directly in the Brother ScanNCut product. You
can also print this file as a hard copy and scan it into a fabriccutting machine. This will ensure that the appliqués will exactly
match the shape and size of the appliqué segments in your
design.
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Use the Page preview tool to preview how the pieces are
arranged on the page when it is printed. The artwork can be
selected and moved to optimize the use of space on the page.
You can also change the orientation of the page using the Page
Preview Offset
tool. This tool sets the location of the top-left
corner of the page.

To use ScanNCut:
1

Create or open a design with appliqué segments in it.
Note that this procedure will apply to outline (.brf) files only. For
stitch files, there is a modified version of the procedure that must
be followed; see “Applying ScanNCut to stitch files.”

2

Select the appliqué segment (or segments) that you want to
print out and scan.

3

Click the ScanNCut

button.

A new, unnamed *.BRF file containing the Artwork segments
will be generated, and will open in a new tab.
The new file will show each appliqué segment as a solid, filled
artwork shape. The fill color will match the original thread color
of the segment.
4

Save the new file.

5

Click Page Preview

. This will display a preview of how

the Appliqué artwork segments will appear on the page; the
borders of the page will be displayed as dashed lines.
Note that the page size displayed here will be determined by the
current print settings; to change page size, select the
Pacesetter button, and then choose Print–Print Settings.

6

Click Page Preview Offset

.

The cursor changes to a cross.
7

Click in the workspace to change (if necessary) the position of
the page to better fit the appliqué you are going to print.
When you click, the center of the cross resets the upper-left
corner of the page at that position.
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8

9

Using the Select tool, drag and move the artwork segments to
fit the page better. If required, the print area will expand to
multiple pages (new page outlines will appear).
Click the Print tool to output the file for scanning.
When printing out ScanNCut files, ensure that “Show
Crosshairs” is not checked in the Print Preferences dialog.

You can also use the Export FCM
Pacesetter

tool (located on the

menu) to output an FCM (Brother Cutter format)

file. This file type can be read directly into the Brother Cutter
machine.
Alternatively, you can use the Export SVG

tool to create an

editable version of the image. The SVG format is a vector format,
which means that it can be edited in vector graphics programs,
such as Adobe Illustrator®. After editing, you can then print a
copy from your graphics program for use in your ScanNCut
machine.

Special note: On creating ScanNCut artwork
from a Stitch file
When you want to create ScanNCut artwork from an appliqué in a
non-outline embroidery file (for example, an imported stitch file,
such as a *.PEC, *.PES or *.DST), a special procedure must be
followed. This procedure involves converting the first run stitch
segment of the appliqué to a specific Brother thread color, which
the ScanNCut tool then converts to a filled artwork segment in
the regular way.
Note that the following procedure may not work in all cases;
particularly, your results may not be correct if the run is not a
closed shape.

To use the ScanNCut tool with stitch files:
1

Open or import a stitch file containing an appliqué.
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2

3
4

In the Color palette, change the current thread chart to
Brother Enhanced Embroidery. For more information, see
“Working with the Color Palette–Selecting a Thread Chart.”
Open the Sequence view and select the first run in the
appliqué.
In the thread palette, change the color of this run segment to
Brother: Applique Material (100), which is located close to the
end of the thread palette.

5

If there are more appliqués in the design, repeat steps 3-4 for
each of the other appliqués, always selecting the first run.

6

Click the ScanNCut

button.

A new tab will open in the workspace, containing the Artwork
segments.
7

Proceed according to the normal ScanNCut procedure,
(steps 4-9 in the previous section).

Merging Design Files
You can merge multiple design files into an active design window.
Click on Merge

to import an existing design file (or files) and

add it them to your design. You can merge design files from a
variety of formats.
Note that the file, once it is merged into Pacesetter Embroidery
Lettering Software, cannot be resized.
Also, the properties of any merged stitch file cannot be modified
using the properties box

To merge a design:
1

Open an existing design, or create a new design.

2

Click the Merge

tool.

You see the Merge Design dialog.
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3
4
5
6
7

In the Look in list, browse to the location of the file you want
to merge.
In the Files of type list, select a design file type for the design
you want to merge.
In the File Name box, select the design file that you want to
merge onto the current open design workspace.
To view a preview of the selected design, select Preview, if
not already selected.
(Optional) Check the Convert to Outlines box.
If this option is selected, the design’s stitch segments will be
converted to outlines. Once it has been converted, you can
save it as a *.BRF file.
Note that stitch files must be converted to outlines in order to
apply the “Remove overlapped stitches” function to them at any
point in the design process.
See “Creating & Editing Appliqué Designs—Removing
Overlapped Appliqué Stitches” for more information.

A preview image of the selected design appears in the small
window on the right-hand side of the dialog.

8

Click Open.
The merged design file appears in the design workspace.
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You can now select and move the stitch file to place it in the
desired position relative to your lettering.

Selecting and Moving Objects in
a Design
The Select Tool
The Select

tool allows you to select and modify individual

design components, or groups of design components. Design
components that have been selected using the Select tool can be
moved, duplicated, or deleted. They can also be resized and
rotated in either direction.
The Select tool is also used to select a number of components in
order to align them as you wish; for more information, see “Aligning design components horizontally and vertically.” The Select
tool can be used for text segments as well; however, to do more
detailed editing of text segments, such as resizing, stretching, or
rotating, you will want to select them with the Text tool.
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For more information on editing with these tools, see the
corresponding sections for each tool under “Creating Lettering.
It is important to note that, whenever you open a design, all the
components will be grouped by default.
Therefore, if you want to use any of the following procedures to
select individual segments of the embroidery design, you must
first Ungroup the design. To do this, right-click on the design (you
will see that the whole thing is enclosed in a selection box) and
choose Ungroup from the context menu.

To select one segment in the design:
1

From the ribbon, click the Select

tool.

2

Click the design component you want to select.
The active segment is enclosed in a selection box.

To select multiple components in the design:
1

On the Ribbon, click the Select

2

Click a design component. Press CTRL on your keyboard
while you click each design component not already
selected.
The active design components will be enclosed in a selection
box with handles.

tool.

To select all components of the design:
Using the Select

tool, click in the workspace, and draw a box

large enough to enclose all components of the design.
•

To select all the design components currently in the active
window, do one of the following:
 Click on the small down arrow under the Select tool on the
ribbon, and choose Select All.
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Press Ctrl + A on the keyboard.

To select in the Sequence View area:
1

On the Ribbon, click the Select

tool.

2

In the Sequence View, select the group of segments which
contains the desired segment or segments; if it is not already
in expanded view, click the small plus sign next to the group
in order to view the list of individual segments in the group.

3

To select one segment, click the segment from the list.
In the design workspace, the active segment is enclosed in a
selection box with handles.

4

To select multiple segments within the Sequence View area,
do any of the following:
 Click a segment. Press CTRL on your keyboard while you
click each segment not already selected.
 Click a segment at the start of your selection. Press Shift
on your keyboard while you click the segment at the end
of your selection. To extend the range of selected
segments, press Shift again or Shift+CTRL while you
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click any segment outside the range of segments
already selected.
In the design workspace, the active segments are enclosed in
a selection box with handles.
5

To edit or change the properties of the segments, do any of
the following:
 In the design workspace, right-click the segment(s) and
choose any of the options available in the edit menu.
 In the Sequence View area, right-click the segment(s) and
choose any of the options available from the menu.
 In the Properties box, alter any property settings as
required.

Copying, Cutting, and Pasting Design
Components
You can use a variety of methods to copy design components in
your designs. You can Copy (or Cut) and Paste using tools on the
Home tab, the right-click menu, or keyboard shortcuts. See the
following procedures.

To copy to the clipboard:
1
2

Select one or more design components you want to copy.
To copy design components to the clipboard, do one of the
following:


On the Home tab, click on the Copy

button.



In the design workspace, right-click on the selection and
choose Copy from the menu.
 Press Ctrl + C.
The design components are copied to the clipboard.
3

To paste design components from the clipboard, do one of the
following:


On the Home tab, click on the Paste



In the design workspace, right-click anywhere and choose
Paste from the menu.
Press Ctrl + V.



button.
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To cut to the clipboard:
1
2

Select one or more design components you want to cut.
To cut design components to the clipboard, do one of the
following:


On the Home tab, click on the Cut



In the design workspace, right-click on the selection and
choose Cut from the menu.
Press Ctrl+X.



button.

The design components are removed from their location.
3

To paste design components from the clipboard, do one of the
following:


On the Home tab, click on the Paste



In the design workspace, right-click anywhere and choose
Paste from the menu.
Press Ctrl + V.



button.

A quick way to Copy and Paste segments is to do the following:
Select it, then press the CTRL key and click. Drag the mouse to
the desired location on your Workspace, and then, release the
mouse button to place the component.

Using the Alignment Tools
You can align appliqué segments, text, or other design
components horizontally or vertically using the Align tools on the
Arrange tab.

To align design segments:
1
2

Select the segments you want to align.
On the Arrange tab of the Ribbon, select the appropriate
button from the following:
Align Left: Aligns all selected objects to the left-most item
selected.
Align Right: Aligns all selected objects to the right-most item
selected.
Align Top: Aligns all selected objects to the top-most item
selected.
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Align Bottom: Aligns all selected objects to the bottom-most
item selected.
Vertical Center: Takes all selected objects and centers them in
the selection box. The objects are moved so that they are
centered top-to-bottom with each other, but they are not moved
left or right.
Horizontal Center: Takes all selected objects and centers
them in the selection box. The objects are moved so that they
are centered left-to-right with each other, but they are not
moved up or down.
Center: Centers the selected objects in the current hoop.
If more than one object is selected, the entire group is moved
together to the center of the hoop; the objects selected remain
in the same position relative to each other as they had before
being centered.

Vertical center alignment

Horizontal center alignment
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Moving Parts of a Design Manually
You can move the component parts of your design relative to
each other by dragging them to another location.

To move a design component manually:
1

From the Home tab, click the Select

2

Click and drag the design component to its new location.
As you drag, the status line displays the horizontal (dx) and
vertical (dy) distance.

tool.

Resizing Segments
Resizing a segment enlarges or reduces it horizontally or
vertically, relative to the percentage you designate. You can
manually resize segments in the workspace, or use the
Transform tab settings available for finer control.
If the Transform tab is used to resize the selection, you have the
option of resizing by absolute size, or a percentage of the
segment’s original size.

To resize segments manually using design handles:
1

Select one or more segments.
The active segment(s) is enclosed in a selection box with
handles.

2

Do one or more of the following to resize segment(s):




To resize by width, click and drag the design handles
located on the left and right side of the selection box.
To resize by height, click and drag the design handles
located on the top and bottom sides of the selection box.
To resize proportionally, click and drag the design handles
located at the top or bottom corners of the selection box.

To resize segments using the Transform tab:
1

Select the segment with the Select tool.
The active segment is enclosed in a selection box with
handles.
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2

In the Transform area of the Properties panel, do one of the
following:




To resize by absolute (linear) values, check the Absolute
checkbox; enter the desired width and height in the
corresponding fields.
To resize by percentage, check the Relative check box;
enter the desired percentage change of width and height
in the corresponding fields.
To maintain the proportions of an object while resizing it, select
Maintain aspect ratio if not already selected

3

Click Apply.

Nudging Segments
Nudging moves the selected design component or group of
design components. Nudging is similar to dragging the design
component but the distance that the design component moves is
smaller.

To nudge up:
•

Use Ctrl +

.

To nudge down:
•

Use Ctrl +

.

To nudge left:
•

Use Ctrl +

.

To nudge right:
•

Use Ctrl +

.
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Deleting Segments
Deleting a design component removes it from the design. The
only way to retrieve a design component you delete is to use the
Undo

tool from the Quick Access tool bar immediately after

you delete it.

To delete a design component:
1

From the Home tab, click the Select

2
3

Select the design component.
There are three ways to delete a design component:

tool.




Right-click and select Delete from the shortcut menu.
Press Delete on your keyboard.



Choose the Delete command from the Home Tab on the
ribbon.

Rotating a Segment
Rotating a design component moves it around the center point of
the selection.The rotate tools on the Arrange tab may be used to
rotate text or merged stitch designs through 90º increments. To
rotate text through a smaller angle, you can rotate the selection
using the frame handles, or by using the Rotate Angle

tool

on the Arrange tab; the Rotate Angle tool allows you to type in an
exact angle of rotation.
See “Rotating the Text Frame” in the section on Creating Text.

To rotate segments manually:
1

Select one or more segments you want to rotate.
The active segment(s) is enclosed in a selection box with
handles.

2

Move your mouse over the blue rotation handle beside the
top, right or the bottom left design handle.
You see the cursor change to a circular arrow.
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3

Click and drag the rotation bead to adjust the box to the angle
you want.
The number of degrees of rotation is displayed on the status line
in the bottom left corner of the workspace window.

To rotate segments using the Transform tools:
1

Select one or more design components you want to rotate.
The active design component(s) is enclosed in a selection box.

2

From the Arrange tab on the ribbon, select one of the
following:
Rotate Left: Rotates one or more selected objects to the left
by 90º increments.
Rotate Right: Rotates one or more selected objects to the
right by 90º increments.
Rotate Angle: When clicked, this will open the Rotation
dialog. In the dialog, enter the exact number of degrees of
rotation you want to apply to the selection, then click OK.

Removing Overlapped Appliqué
Stitches
When you create a design containing multiple appliqués, and
some of them are overlapped by other segments, there is a
function that will remove the portion of the border stitches that is
underneath the overlapping segment. Note that the placement
and tackdown stitches in overlapped portions of the applique will
not be removed.
The “Remove Overlapped Stitches” function will also work if the
appliqué is overlapped by an “accent” design – that is, one of the
pre-installed designs that are added with the Add Designs
tool.
Note, however, that “Remove overlapped stitches” will not be
applicable to designs that are brought in using the Merge tool.
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This function also allows you to retain some of the overlapped
border stitches; this is done by setting an Allowed overlap
distance. Leaving some overlap helps eliminate the gaps that can
sometimes occur when all the overlap is removed.

To remove overlap:
1

Select the top segment that overlaps other segments or
designs.

2

Right-click, and choose Remove Overlapped Stitches from
the shortcut menu.
You see the Allowed overlap distance dialog.

3

To retain some overlap between the stitch segments, type the
distance in the box, and click OK.
The default is set at 0.5 mm. This will prevent any gaps from
occurring when stitching the design.

The underlying stitches are removed.
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In this example, the overlapped portion of the border stitches of the underlying
appliqué segment has been removed (shown by moving the top segments
aside). Notice, however, that the tack-down and placement stitches have
been retained.

Working with the Color Palette
In Pacesetter Simply Appliqué, you can change the color (thread)
of any segment of your design. If you can select it, you can
change its color.

The color palette, which is located along the top edge of the
design space, shows you the thread color in the thread chart that
is currently selected.

Selecting a Thread Chart
Pacesetter Simply Appliqué comes with a large number of the
most popular manufacturers’ thread charts already loaded. You
are able choose from amongst these charts by clicking on the
Thread Chart button

, which is on the left end of the palette.

This will display the whole list of thread charts as a drop-down
list. Click on the one that you want, and those thread colors will
be loaded into the color palette.
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Searching for a Specific Color
The Find button

, located near the left end of the thread

palette, allows you to search for a particular thread in the palette,
if you know the name or thread number.

To search for a thread color:
1

Click the Find

button.

2

Type in all or part of the name or number of the thread.

You see the Thread Color Search dialog.

If you only know part of the thread name, and there is more than
one possible match for that partial name, the search dialog will
present you with a number of choices (as in the example
below).

3
4

When you have found the color you want, click on it to select
it.
Click the Find button.
The color you were looking for will now be the selected color in
the palette.

Changing a Thread Color
Pacesetter Simply Appliqué allows you to adjust the colors of the
lettering you create, or indeed any segment of the design, by
using the Color Palette; you do this by choosing thread objects in
the Color palette.
When changing the color of a lettering segment, you can select
it with either the Text tool or the Select tool; however, other
types of segments (such as those imported with the Merge tool)
must be selected with the Select tool.
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To change thread colors:
1

Do one of the following:


2

Select a segment in the workspace with the Select tool or
one of the text tools.
 In the Sequence view, click on one of the segments.
In the Color Palette, click the color box with the thread color
you want to use.
If you hover over a color square on the palette, the thread type
and number will show beside the mouse pointer.

Garment Templates
Garment Templates is a feature that allows you to see how your
embroidery design will look in the context of an actual garment,
without having to sew it out. In this feature, you choose a graphic
representation of a garment from a list, and then select a
background for it – you can choose either a solid color for this, or
one of a number of fabric patterns.
You can incorporate text segments and/or designs into the
Garment Templates, and save it as a *.BRF file. When you reopen this file, both the design and garment information (e.g.,
fabric or color and size) will be retained.

To use Garment Templates:
1

Create a new design, or open an existing file

2

On the Home tab, click the Garment Templates
You see the Garment Templates dialog.

icon.
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3
4

From the garment drop-down list, choose a garment template.
To select the background of the garment, do one of the
following:


To choose a solid color:
 Click the color chip next to the Garment field.
You see an array of color swatches.
 Click on the “swatch” of the desired color.
If you want to select a different color for the garment template,
click on the More Colors button at the bottom of the given array
of color swatches. This will open up the Color dialog, where
you can choose any RBG color available from the palette.



The Garment color will change to the selected color.
To choose a fabric background:
 Click the Select... button.
You see the Fabrics dialog, which shows thumbnail images
of the fabric patterns available.
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5

Choose a fabric from the list:
The pattern of the selected fabric will appear in the
workspace.
(Optional) Change the height and/or width of the garment
template. Do one of the following:



Type a value into the Height or Width boxes.
Enter a percentage change in either of the boxes that
have the% symbol following them.
The “Keep aspect ratio” box is checked by default; this ensures
that the height and width stay proportional to each other as you
change the value of one or the other. To change the height
without changing the width, or vice versa, uncheck this box.

6

Click Okay.
The garment appears in your workspace.
Once the garment is on screen, you can select it and rotate by
clicking and dragging on the blue circles around the handles.
You can also resize the garment template manually on screen,
by clicking and dragging the black square handles at the corners
of the selection frame.
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Using the Line and Shape Tools
Drawing Lines
You can use the Line tool to create artwork (that is, outlines without
stitches) in designs. You can draw either straight or curved points.
Use the Close Shape tool to convert an open shape to a closed
shape. These artwork designs can then be converted into printable
image files, using the ScanNCut tool (see above).
If you make mistakes as you draw, you can undo your last action
by pressing Backspace on your keyboard; this will remove the
points one at a time, in reverse order.

To create lines with the Line Tool:
1

On the Tools tab, select the Line

2

Click in the design workspace to place points:

tool.




To place a straight point, click in the design workspace.
To place a curved point, press and hold CTRL on your
keyboard while clicking.
 To begin creating a straight line again, release CTRL on
your keyboard.
You see the curve previewed in the workspace as you place
the anchor points.
3

To close the segment, do one of the following:


4

On the Tools tab, click the Close Shape

tool.

 Press H on your keyboard.
Right-click to complete the segment.
Click on Apply Stitches to add a stitch type to the segment.

Editing Artwork with the Edit Shape
Tool
Use the Edit Shape

tool to add or delete anchor points

(nodes) on an vector artwork segment (such as those created
with the line tool) or embroidery segment that contains outline
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(e.g., a run, satin, or appliqué). When you select the segment,
and then select the Edit Shape tool, the anchor points appear as
blue squares along the outline of the shape.
Adding anchor points gives you finer control over the shape of
the outline segment; when you delete anchor points you simplify
the outline.
You can also use this tool to move the anchor points, allowing
you to modify the shape of an existing line or shape.

To add an anchor point:
1

Select a segment.

2

On the Tools tab, click the Edit Shape

3

Right-click the location where you want to add an anchor
point.
You see a context menu.

4

Choose Add Point from the shortcut menu.
The new point appears on the selected line.

tool.

To delete an anchor point:
1

Select a segment with the Select

tool.

2

On the Tools tab, click the Edit Shape

3

Right-click the anchor point you want to delete.
You see a context menu.

4

Choose Delete Point from the shortcut menu.
The anchor point is removed from the selected line.

tool.

To change the shape of an existing artwork outline:
1

Select a segment with the Select

2

On the Tools tab, click the Edit Shape

3

The anchor points appear on the segment, as small blue
squares.
To re-shape the outline, do the following:

4



tool.
tool.

Click and drag on an anchor point to move it to the
desired position.
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5
6

 Release the mouse button.
Repeat step 4 for any other anchors, as required.
Click in an empty area of the workspace (or click on the
Select tool) to de-select the Edit Shape tool.
The outline will take on the new shape.

Changing the Properties of an Anchor Point
Using the Edit Shape tool, you can change the properties of an
anchor point. By default, when an anchor is placed, it will create
straight point - which is to say, the angle of the lines on either
side go straight to the adjacent anchor points. The point may be
moved, but there are no direction lines that can be move to
change the shape of the path.
However, when the Edit Shape tool is active, you can right-click
on the anchor point and change the given straight point to a
smooth or cusp point, which have direction lines that you can
click and drag to change the corner shape.
To change anchor point properties:
1

Select a segment with the Select

2

On the Tools tab, click the Edit Shape

tool.
tool.

The anchor points appear on the segment.
3

Right-click an anchor point.
You see a context menu.

4

From the context menu, select one of the following:




Cusp: Allows editing (direction and length) of the
direction lines on either side of the anchor point; permits
yo u to make a sharp (or shallow) bend to a curve.
Smooth: Constrains the angle of the direction lines to
180º and allows you to vary the length of the direction line
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side of the anchor point. Creates a smooth transition on
either side of the point.

The original artwork (Line Tool) segment.

The original segment with the point of the right triangle converted to
cusp, and the direction lines adjusted to create a sharp peak

The same segment with the point of the right triangle converted to
smooth.
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Converting to Appliqué
The Convert to Appliqué

tool instantly converts a selected

outline segment into an appliqué, complete with positioning,
tackdown, and border stitches. This tool may be applied to any
embroidery segment, just so long as it contains outlines (e.g.
*.BRF file). It will also convert artwork segments, such as
imported *.FCM files, or artwork that has been created within
Pacesetter Simply Appliqué using the Line

tool.

When a segment has been converted, it will be assigned the
default appliqué properties; however, you can modify any of
these (e.g. Appliqué border, stitch length, offsets) in the
Properties Panel; see “Appliqué Properties,” below, for more
information.

To convert a selection to appliqué;
1

Using the Select tool, select the segment (or segments) that
you want to convert.

Two normal fill segments selected for conversion to appliqué.

2

On the Tools tab, click the Convert to Appliqué
The segment(s) will be converted to appliqué.

3

Adjust properties in the properties panel.

tool.
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The design after conversion to appliqué, thread color change, and adding
fabric backgrounds.

4

Save the file.

Printing Designs
You can make print-outs of your designs in Pacesetter Simply
Appliqué. These print-outs not only give you a preview of what
the design will look like, but they have a lot of other information
as well - the number of stitches in the design and its overall size.
Also, by selecting the “Print Color Analysis” option in the Print
settings dialog, you can also have printed the color, name, and
length of each thread used.

Previewing a Design before Printing
You can preview a worksheet on the screen before sending it to
the printer.

To preview a design:
1

From the Quick Access Toolbar, click on the Print Preview
button.

2

To zoom in and out of the previewed worksheet, do the
following:


To zoom in on the worksheet, click Zoom In and scroll to
view specific parts of the design.
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3

To zoom out on the worksheet, click Zoom Out and scroll
to view specific parts of the design.

To close print preview and return to the design window, click
Close.

Printing Design Worksheets
You can print a design, without previewing it, by selecting the
Print Setup

tool. This button opens your computer’s Print

dialog, where you can choose printer options such as how many
copies you want to print.
You can also print worksheets of your design immediately,
without previewing the design or changing printer options. To do
this, choose the Direct Print

button.

To print a worksheet for your design:
1

Do one of the following:


Click the Print Setup

button.

 Press Ctrl+P on the keyboard.
You see the Print Setup dialog.
2
3

Make any required changes to the print settings.
Click OK to send the file to the printer.

Changing the Print Settings
You can customize print settings for your embroidery designs.
Pacesetter Simply Appliqué allows you to adjust the image and
worksheet information displayed in design printouts.

To change a design’s print settings:
1

Click the Pacesetter Button
Preview

, and select Print—Print

from the menu.

You see the print preview window, displaying your design.
2

On the preview’s toolbar, click Settings.
You see the Print Settings dialog.
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3
4
5

In the Margins area, enter the margin sizes you want for your
design worksheet.
Select Print Actual Size to have your design print in its actual
size.
Select Print In One Page to print the design on a single
worksheet page.
If Print Color Analysis is selected along with Print In One Page,
your print out will display a basic thread sequence view. This
includes a simplified view of the colors used, the color sequence
and the thread consumption.

6

Select Print Company Name to have the name of your
company name printed on your design worksheet.
Enter your company name in the box below.
7 To prevent jump stitches from showing on your print preview,
check the Remove Jump Stitches box.
8 Select Print Color Analysis to print an expanded thread
sequence view that includes a view of the colors used, the
color sequence, and the thread consumption for each color.
9 Select Show Crosshair to print a set of crosshairs
superimposed on the design print-out.
10 Click OK to save the changes to print settings.
11 Click Print to print out the print preview, or Close to exit
without printing.
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CHAPTER 3:

Creating Text &
Editing Text Properties
The Pacesetter Simply Appliqué Text tool allows you to add
lettering to your appliqué designs. The software includes both
appliqué and regular embroidery fonts.
Topics covered in this chapter:
• Creating lettering with the Text tool
• Working with blocks of text and individual letters within text
segments, to adjust their size, shape, and orientation
• Changing the thread colors of lettering - whole blocks of text
of individual letters
• Adjusting text properties using the properties panel
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Creating Lettering
Text segments are created using the Text

tool. It can create

single or multiple lines of text in the same segment.
The text will be generated as a straight line and with the normal
proportions of the given font; however, you can use the frame
handles surrounding the lettering to modify its shape. See the
sections below, “Adjusting Text Frames” and “Working with
Individual Letters.”

To create normal text:
1

On the Home tab click on the Text

2

Click once in the design window.

tool.

If another text item was already selected, your first click only deselected that item. You will have to click again to place a new text
segment.

An empty text frame appears in the workspace and the mouse
pointer changes to an arrow with the letter A next to it
.
3

4

5

Type the desired text; to create a multi-line text segment,
press ENTER, which will drop the cursor down one line, and
continue to enter your text.
Right-click to complete the text segment.
Your text appears in the design. You can now make any other
changes to the text segment in the Text Properties box.
To change the font, do the following:


6

In the Text area of the Properties panel, click on the
down-arrow to the right of the font field.
You see a list of fonts.
 Select the desired font from the list.
A preview of the selected font is displayed at the top of the
properties panel.
Click Apply in the Properties panel.
The selected font will be applied. For more information on
changing other text settings, see “Adjusting Text Properties”.
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Working with Text Frames
In Pacesetter Simply Appliqué, you can modify your lettering in a
number of different ways once you have created it. You can
change the overall size of the text, the height, the slant, the spacing between letters (kerning), and so on.
There are two main methods of changing the size and shape of a
text segment: directly, by clicking and dragging on the outline
handles in the workspace, or indirectly, by changing the
parameters of the Properties panel. The following sections will
show you how to use handles for direct text manipulation; for
more information about how to use the Properties panel, see,
“Adjusting Text Properties”.

Adjusting Size of a Text Segment
To change the size of a text segment manually, you can use the
Proportional Sizing handle. This is the green arrow located on
the top-left corner of the text frame.

Click and drag on the handle to change the overall size of the
text; up to increase the size, or down to decrease the size. Notice
that, with this handle, the size of the text changes proportionally;
that is, if you increase the size of the segment, the letters will
increase in height by the same degree that they increase in
width.
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Adjusting the Width of Text
If you want to change the width of the text of segment, without
changing the height, use the frame’s Width Handle.

The Width Handle is the green arrow at the bottom-right of the
text frame. Click and drag it to the right to increase the width, and
to the left to decrease the width
If you want to adjust the height of a design, it can be done in the
Height box in the Text tab. Enter the new size and click Apply.

Adjusting the Corners of Text
Segments
Use the Corner Handles to change the shape of a text segment.
The Corner Handles are at each corner of the text frame, and are
pink in color.

When you click and drag these handles up or down, they change
the position of the selected corner of the text frame; when you
release the mouse button, the embroidery is regenerated to
match the change in shape. This gives you the ability to create
text that slopes up or down.
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Using the Envelope Handles
When selected with the Text tool, a text segment will be
surrounded by a flexible bounding box, called an envelope. You
can adjust this shape by moving the Envelope Handles.

The Envelope Handles are the pink circles, located at the midpoint of the top and bottom borders of the text frame. Click and
drag these handles to make the top and/or bottom of the frame
concave (“bowed in”) or convex (“bowed out”).

Rotating Text
Use the Rotation Handle to change the angle of a text segment.
This is the orange circle at the top-left corner of the text frame.
To rotate a segment, first position the mouse over this handle so
that the cursor will changes to a circle-arrow handle

. Then,

drag the handle to rotate the segment to the desired angle. Drag
up to rotate counter-clockwise, and down to rotate clockwise.
Notice that, as you rotate, the tool displays an outline preview of
the lettering, showing how far you are rotating it. Release the
mouse button to “drop” the segment, and generate the stitches at
the new angle.
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Dragging this handle rotates the design to any angle. You will see
an outline of the design rotate onscreen as you are dragging, and
the text will be regenerated when you release the mouse.

Adjusting the Slant of Text
The angle of the letters in a text object can be adjusted with the
Slant Handle. The Slant Handle is the square blue handle located
in the lower-left of the selection box.

To adjust the slant of text, select the text object you want to
adjust, click the Slant Handle and drag. To add a forward
(positive) slant to the letters, drag to the right and to add a
backward (negative) slant, drag to the left.

Reset Frame
The Reset Frame function allows you to undo any of the frame
adjustments described above (e.g. rotating, changing the
envelope, etc.) and restore it to the original state. All frame
adjustments will be undone.
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To reset a text frame:
1
2

Select one of the text tools.
Select the text frame, and right-click.
You see a context menu.

3

Click Reset Frame.
The text will be return to the original state.

Working with Individual Letters
With the Text tool selected, you can make changes to individual
letters within the text segments in your designs. You are able to
select a letter, and move it, rotate it, and resize it by using the
handles that surround the letter when it is selected. You can also
change the spacing of letters within the word with the special
kerning handles.
Notice that the Frame Handles change to a different color
when an individual letter is selected.
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Adjusting the Space between Letters
(Kerning)
The space between individual letters can be adjusted using the
Kerning Handles.

Kerning Handles are blue diamonds, located between the letters
of your text segment. You can drag these horizontally to adjust
the spacing of the text.
When you move a Kerning Handle in a word, you adjust the
space between only the two letters on either side of the handle
you are moving; the spacing between the other letters remains
the same. So, if you add space, you will see the whole length of
text expand by this amount.

Moving Individual Letters
Individual letters can be moved using the Letter Handles. These
appear as blue squares, centered on each letter in the segment.

To select a letter, click on its Letter Handle; once the individual
letter is selected, you can adjust its position by dragging with the
mouse.
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Selecting a letter also activates the Letter Frame around that
letter. This frame displays handles that allow you to resize or
rotate it; see following sections.

Resizing Individual Letters
When an individual letter has been selected, you can resize it by
clicking and dragging the Letter Size Handles. The Letter Size
Handles are green squares that are located in the corners of the
letter frame.

When you hover over these handles, a double-ended arrow
appears; by dragging up or down on this handle, you increase or
decrease the size

Rotating Individual Letters
When you select an individual letter with its Letter Handle, you
can rotate it by clicking and dragging the Letter Rotation
Handles. The Letter Rotation Handles are the green circles at the
corners of the Letter Frame. When you hover over these handles,
the mouse pointer will become a circle with arrows, like this.
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Drag up to rotate counter-clockwise, and down to rotate
clockwise. As you rotate, the tool displays an outline preview of
the letter, showing how far you are rotating it..
When the cursor is placed over the Text Function Handles, the
cursor changes for the different functions.

Working with Color
With Pacesetter Simply Appliqué, you are able to choose a text
item’s color from a large variety of thread colors. You apply the
color by selecting from the colors available in your currently
loaded thread palette.
For more information on how to use the thread palette, and how
to change the current thread palette, see “Working with the Color
Palette.”

Changing the Color of a Text
Segment
The following procedure applies to situations where you want to
simply change the thread color of an existing text segment to a
new color.

To change the thread color of a Text item:
1

Do one of the following:


2

Select the text item in the workspace, using either the
Select tool or one of the text tools.
 Click on the text item in the Sequence view.
In the Color Palette, click the color box with the thread color
you want to use.
If you hover over a color square on the Palette, the thread type
and number will show beside the mouse pointer.
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Changing the Color of Letters Normal Embroidery
If an individual letter has been selected, its color can easily be
changed. Selecting the letter allows you to select a new color
from the color palette.

To change colors of individual letters in a text segment:
1

Using one of the text tools, select a text segment.
The selection frame and letter beads appear on the text.

2

Select the letter you want to change by clicking on its letter
bead (blue square superimposed on the letter).
The letter is enclosed in a selection frame.

3

Click a color in the Color Palette to change the color of the
letter.
The letter will change to the selected color.

4
5

Repeat steps 2 – 3 for each letter you want to change.
Click elsewhere in the workspace to de-select the text.
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Changing the Color of Letters Appliqué Lettering
In order to stop the machine so that you can place the fabric
pieces to be sewn on to the garment, the Appliqué Style lettering
segment inserts a color change between each positioning,
tackdown, and border segment. This means that, when first
generated, the lettering segment will display many colors.
You can change the colors of lettering in an Appliqué segment by
selecting a color from the list on the Color Palette.
In the normal sewing-out of an Appliqué text segment, the
machine will not stop between the border stitches of one letter and
the positioning stitches of the subsequent one; so, the last color of
one letter (the border stitches) will be the same as the first color of
the next (that letter’s positioning stitches).
However, you can force the segment to stop between letters by
inserting the tilde symbol (~) between letters. (In the example
below, you would type B~E~S.) If you add these stops, there will
be three stops for each letter, and changing every third thread will
change the color of the corresponding letter’s border stitches.

To change the color of letters in an Appliqué Text
segment:
1

Select the Appliqué Text segment.

2

In the color palette, find the color you wish to apply to the
first letter of the segment, and click on it.
You see the a menu of colors.
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3

To set the color of the first letter, in the Options menu, click on
Color 3. (In the first letter of an Appliqué-style text segment,
Color 1 refers to the positioning stitches, and Color 2 to the
tackdown stitches; Color 3 is the thread color of the visible
border stitches).
The first letter changes to the chosen color.

4

Choose the color you wish to apply to the next letter and click
on it.
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5

From the menu, click on Color 5. (For the second letter of the
appliqué segment, the positioning stitches will be sewn using
thread color 3, and the tackdown stitches color 4).
The second letter will change to the chosen color.

6

Repeat steps #4 and #5 for each letter in the segment,
changing every other color in the appliqué segment, until you
have changed all the colors required.
Alternatively, you can change colors by expanding the Appliqué
segment in the Sequence View. Then, each portion of the appliqué
(positioning, tackdown, and border) can be selected individually.
Then, you can change the color of the selection by clicking on the
desired color in the color palette.

Creating Multi-color Text for Regular
Embroidery Fonts
When you are creating design compositions involving lettering,
you may find that you want to have two or more colors in a single
line of text. In Pacesetter Simply Appliqué, this can be easily
done using the Properties panel.
You accomplish this by inserting a special character, the tilde (~)
into your text. Inserting these characters divides your text
segment into sub-segments; each of the sub-segments that are
created this way gets its own color change identifier label
(Color1, Color2, etc.). These color changes can then be assigned
its own thread color on the Color Palette.

To insert thread color changes within a text segment:
1

Select the text segment.

Creating Text & Editing Text Properties 97

2

In the Text field of the Text Properties panel, type a tilde (~)
between letters in each position that you want a color change
to occur.

3

Click Apply.
You see the colors change for all text sub segments after the
first one, which retains the original color.

The text segment, as it appears initially, after being divided into sub
segments. The first subsegment retains the original color, and the subsequent
ones are assigned arbitrary “placeholder” colors (until you chose your own).

4

To apply your choice of colors to the sub-segments, move the
mouse pointer to the desired color in the Color Palette and
left-click.
A context menu appears, listing the text sub-segment color
change numbers in the order they appear.

Selecting the colors for the individual sub-segments; in this example, applying
a red thread color to the first segment, the word ‘Multi”.
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5

From the context menu, click on the appropriate color change
number to apply the chosen thread color to it.
The sub-segment changes to the chosen color.

6

Repeat step 5 for each sub-segment in your list.

The text segment with new thread colors applied.

The example outlined above demonstrates two color changes
being applied between words, but you can apply changes in
exactly the same way between individual letters in a word.
Note that the tildes do not add any space between characters or
whole words in your text.

Auto-inserting Color Changes into
Text
The Auto Insert Color Change feature is another way to quickly
and easily create multi-color text. This tool automatically inserts
a color change between each letter in the selected text.

To auto-insert color changes in a text segment:
1

Select a text segment.

2

In the Text field of the properties panel, click the Auto Insert
Color Change

button.
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3

Click Apply.
A color change will be placed between each letter in the text
segment.

In the properties panel, note that the color changes will appear as
tildes (~) between each letter. If you want to have a fewer color
changes in the text, you can achieve this by manually deleting
some of the tildes in the text field; click Apply to see the changes.

4

To change the colors of individual letters, move the mouse
pointer to the desired color in the Color Palette and left-click.
A context menu appears, listing the color changes in the order
they appear in your text.

5

From the context menu, click the appropriate color change
number to apply the chosen thread color to it.
The letter changes to the chosen color.

6

Repeat steps 4- 5 for each sub-segment in your list.
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Adjusting Text Properties
The Properties panel appears (in the default configuration) to the
right of the workspace. It displays, and allows you to modify, all
the properties associated with the lettering in your designs.

You can use this area of the panel to change the lettering,
choose a font, and select the height, alignment, and spacing of
the letters, among other properties.
If you need to make room in the Properties panel in order to see
some of the fields better, you can collapse one or more areas by
clicking the small minus sign next to its name; the box will then
display a small plus sign. Clicking on the plus sign expands that
area again.

The properties that you will see displayed will be slightly different
depending on which type of text segment (normal embroidery or
appliqué) is currently selected.
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Changing the Text
As well as being able to type directly on the screen, you can also
input your text by entering it into the Text field on the Properties
panel.

To edit text in the Properties panel:
1
2

Select the text object you want to edit.
In the Text area of the Properties panel, click in the Text field
to select it.
If the Properties panel is not already visible, you can display it
by pressing Alt + Enter on your keyboard.

3
4

Type the desired text into the Text field.
Click Apply to save your changes.

Changing the Font
You can change the font type of text objects using the drop-down
list of fonts in the Properties panel. At the top of the area, you
see a preview image showing a sample of the selected font.

You can choose from two types of fonts at the outset; embroidery
fonts or Appliqué fonts. For more information, see “Displaying
font properties.”

To change a font type:
1

Select the text segment you want to alter.
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2

From the Font list, select the font you want to use.
You can preview the fonts available by clicking the arrow to the
right of the font name. This will display a drop-down list of the
available fonts; scroll through the list by dragging the track button.
You can click on each font name to display a preview of the font
in the Text area, at the top of the properties area.

3

Click Apply to save your changes.
You see your text’s font type altered accordingly.

Displaying a Font’s Available
Characters
In Properties panel, there is a tool which displays all the
characters (keystrokes) that can be entered for available
embroidery fonts. For example, some fonts only allow you to
enter uppercase characters, while other fonts allow you to enter
both uppercase and lowercase characters. The available
characters box also tells you the minimum and maximum
recommended heights for sewing out the font.

To display an embroidery font’s available keystrokes:
1
2
3

Display the Properties panel, if it is not already visible.
In the Text area, select the font you want to use in the Font
field.
Do one of the following:


Click on the available characters button
to the
immediate left of the font field.
 Hover the mouse pointer over the font preview image at
the top of the Properties panel.
A new window displays all the available keystrokes.
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Adjusting the Height of Text
The Height property refers to the tallest character in a given font.
So, when a text segment contains both uppercase and lowercase
letters, it is the size of largest uppercase letters that (usually) is
set by this property.

To change the height of lettering:
1
2

Select the text object you want to alter.
In the Text area of the Properties panel, select the Height
field.
The property label (Height) is highlighted in blue.

3
4

Type in the height you want your letters to be.
Click Apply to save your changes.
You see your text’s height altered accordingly.

Adjusting Letter Spacing
The font spacing property controls the horizontal spacing
between letters in a text segment. The normal (default) value for
the font spacing is zero. You can set the font spacing to a
negative or a positive value. If you set the value to less than
zero, then the spacing between letters decreases; if you set the
value to greater than zero, then the spacing increases.
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Notice that the spacing property applies to the whole segment. If
you want to change the spacing selectively, to individual gaps
between letters, you can use the Kerning Handles. See
“Adjusting the Space between letters.”

To change font spacing:
1
2
3
4

Select a text segment.
In the Text area of the Properties panel, click in the Spacing
field to select it.
Enter the font spacing value you want to use.
Click Apply to save your changes.
You see your text’s letter spacing altered accordingly.

Changing the Slant Setting
Use the Slant setting to create a slanted effect in text objects.
Slant changes the angle of the lettering, away from the vertical. A
negative value slants your lettering to the left; a positive value
slants it to the right.

Negative slant to the left and positive slant to the right.

To change slant settings:
1
2
3

4

Select the text object you want to alter.
In the Text area of the Properties panel, select the Slant field.
Enter the slant value you want to use. To slant your lettering
to the left, enter a negative value. To slant your lettering to
the right, enter a positive value.
Click Apply to save your changes.
You see your text altered accordingly.
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Adjusting Width Percentage
The Width Percentage changes the overall width of a text
segment. You can adjust the Width Percentage to alter the
appearance of the text object, or to allow it to fit the hoop better.
When you change the width of a segment using the Width
Handle, the Width Percentage of the selected segment will be
adjusted automatically to reflect the change.

To change Width Percentage:
1
2
3
4

Select the text object you want to alter.
In the Text area of the Properties panel, select the Width field.
Enter the Width Percentage value you want to use.
Click Apply to save your changes.
You see your text’s width percentage altered accordingly.

Sew Sequence
This setting determines the position in the text segment at which
the sewing will begin. Choose between Left, Right or Center.

Setting the Connection Type
Use the connection type settings to choose the way that letters
are connected in lettering. The connection types are As Digitized,
Closest Point, and Furthest Point.

To set the Connection type:
1

2

In the Text area of the Properties panel, select one of the
following from the Connection list:
 Select As Digitized to connect lettering using the original
digitized order.
 Select Closest Point to have the connections move to the
closest point between letters.
 Select Furthest Point to have the connections more to the
furthest point between letters.
Click Apply.
The connections will be adjusted accordingly.
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Line Spacing
This property controls the spacing between lines in multi-line text
segments. This quantity is expressed as percentage of the text’s
height property.

Align
The Align setting only applies to lettering segments with more
than one line. This property is equivalent to the alignment of
paragraphs in word-processors; you can align your text on the
left, right, or center.

Resetting the Text Frame
You can right-click on any text object, regardless of its type, and
an edit menu will appear. This menu allows you reset the form of
the text frames.

Resetting the Frame
The Reset Frame command is useful when you have altered your
text object a bit too much and want to start over. For details on
the procedure, see Creating Text—Text Frames-An Overview—
Reset Frame.

Resetting Individual Letters
If you have selected a single letter in a text segment, the context
menu will have an additional option, the Reset Letter command.
Use this command in cases where you have manipulated a letter
and want to reset it so that it looks as it would if it was never
individually adjusted.
This command is available when you activate individual letter
size handles and right-click the individual letter.
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Appliqué Text Properties
If you need to create large letters, Appliqué style text is one way
to reduce the number of stitches required. With appliqué
lettering, you use cut pieces of fabric in place of large fill stitch
areas.

There are three different embroidery segments for each letter in
appliqué style text:
•

Positioning stitches. These sew onto the garment first, and
serve as a guide for placing the appliqué fabric.

•

Tackdown stitches. Once you have place the appliqué fabric,
the tackdown stitches hold it in place.

•

The appliqué border. Border stitches run all the way around
the outline of each letter to securely attach the appliqué fabric
to the garment.

Appliqué Border Settings
There are four different kinds of border stitches that can be
applied to appliqué borders: Satin, Motif, Blanket, and Run. The
specific properties that can be adjusted for your lettering depend
to some extent on the type of border stitch you specify. For more
information about the settings for each of these types, see the
procedures for each type.
Properties that all types of appliqué lettering have in common,
such as tackdown offset and fabric fill, are each dealt with in their
own sections.
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Satin Settings
You can modify the settings and make all changes to the satin
stitches in the Appliqué box.

To adjust Satin stitch settings for appliqué:
1
2
3

Select the Appliqué text segment.
In the Properties panel, in the appliqué type field, select
Satin.
Adjust any of the following settings in the Properties panel:





In the Stitch Length box, enter the stitch length of the
placement and tackdown runs.
In the Appliqué Width box, enter the width of the satin
stitching.
In the Appliqué Density box, enter the density of the Satin
stitching.
In the Inset (%) field, enter the Inset percentage value.
The Inset percentage setting determines the placement of
the satin border relative to the outline of the letters. A
value of 0% means that the satin will be just outside the
outline, while a value of 100% means it will be just inside
the outline. By default, the inset is set at 50%, which
places the middle of the satin over the outline.

Examples of Satin appliques with different inset percentages applied:
0% (left), 50% (middle) and 100% (right).

4

Click Apply.
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Blanket Settings
After you select the appliqué stitch type, you can adjust any of
the default settings available. You must make all changes to the
appliqué stitches from the appliqué box.

To adjust blanket settings for appliqué:
1
2
3

Select the appliqué text segment.
In the Properties panel, in the Appliqué Type field, select
Blanket.
Adjust any of the following settings in the Properties panel:


4

In the Stitch Length box, enter the stitch length of the
positioning and tack down runs.
 In the Appliqué width box, enter the width of the blanket
stitching.
 In the Blanket density box, enter the spacing for the
Blanket stitching.
Click Apply.

Motif Settings
After you select the Appliqué Stitch Type, you can adjust any of
the default settings available. All changes to the appliqué
stitches are made in the appliqué section of the Properties panel.

To adjust Motif settings for appliqué:
1
2
3

Select the appliqué text segment.
In the Properties panel, in the Appliqué Type field, select
Motif.
Adjust any of the following settings in the Properties panel:
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In the Stitch Length box, enter the stitch length of the
positioning and tack down runs.



In the Inset (%) field, enter the Inset percentage value.
The Inset percentage setting determines the placement of
the motif stitches relative to the outline of the letters. A
value of 0% means that the motif will be just outside the
outline, while a value of 100% means it will be just inside
the outline.
By default, the inset is set at 50%, which places the
middle of the motif over the outline.

Examples of Motif appliques with different inset percentages applied:
0% (left), 50% (middle) and 100% (right).



4

From the Motif list, select a Motif pattern that will be used
as the appliqué stitching.
 In the Motif Stitch Length box, enter the motif stitch
length. The motif stitch length affects the size of the motif
and represents the length (width) of each motif pattern.
Click Apply.
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Run Settings
The Run style creates a border of the lettering to a run stitch. For
a Run applique, the adjustable settings are stitch length and style
of Run.

To adjust Run settings for appliqué lettering:
1
2

Select an appliqué text segment.
In the Properties panel, in the Appliqué Type field, select
Run.
The Run style properties become active.

3
4

In the Stitch length field, enter a length for the Run stitches.
In the Run Type field, select one of the following run types to
apply to the border stitches:






A Single Run stitch is a simple forward-moving stitch that
looks like any straight stitch produced by a sewing
machine.
A Double Run stitch sews over the line twice: once
forward, and once backward, thus it ends up where it
starts.
The Bean stitch (also known as Three-ply stitch) is a
running stitch where the machine sews over each stitch
three times (forward, back, forward again) before it moves
to the next stitch. The result is a heavy running stitch.

Tackdown Offset
The Tackdown Offset property is applicable to all types of
appliqué text.
The Tackdown Offset settings shifts the tackdown stitches
inwards or outwards, relative to the outline, by the specified
distance (displayed in mm). Enter a positive number to shift them
outwards, or a negative number to shift them inwards.

Setting the Tackdown Offset distance:
1
2

Select the appliqué text segment.
In the appliqué area of the Properties panel, select the
Tackdown Offset field.
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3
4

Enter the value for the offset (in mm).
Click Apply.
The tackdown stitches will be adjusted accordingly.

An appliqué letter (Run border style) with a negative tackdown offset applied
to it. The tackdown stitches (red) are inset from the border stitches (blue) by
2.0 mm.

Fabric Backgrounds in Appliqué
Style Text
The Fabric Background Property is applicable to all types of
appliqué text.
You have the option of selecting a fabric background to display
within the appliqué border. You can select either from a list of
fabric images provided with Pacesetter Simply Appliqué, or
import your own image file to use as a background.
The fabric image you apply will also be visible in the print
preview of the design.

To display a fabric background in an Appliqué segment:
1
2
3

Select the appliqué text segment.
In the Appliqué area of the Properties panel, select the Fabric
field.
In the Fabric field, click Select...
The Fabrics dialog pops up in front of the workspace.
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4
5

Select a fabric from the dialog by clicking on its swatch.
Click Ok.
The selected fabric image appears within the appliqué border.

To remove the fabric background from the lettering, click the
Select button again to re-open the Fabrics dialog. In the dialog,
select the “None” swatch, and then click OK to close the dialog;
the background will be cleared.

To import an image for an appliqué background:
1
2

Select the Appliqué Style segment.
Open the Properties panel.
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3

In the Appliqué area click Select... next to the Fabric field.
The Fabrics dialog will open.

4

On the Fabrics dialog, click Add...
You see the Import fabric dialog
You can scan your own images of fabric swatches for use in your
design projects. For best results, scan them with a resolution of
300 dpi. A 1 in. × 1 in. piece of fabric should be sufficient for your
sample.

5
6

Browse to the location of the image you wish to use as a
fabric.
Select the image and click Open.
The image appears within the appliqué border, and it is added
to your Appliqué Fabric list.

Adjusting Fill Settings
In the Properties panel, you can customize the parameters used
by Pacesetter Simply Appliqué when it generates the fill stitching
for the segment. You have the option to add a pattern type and
change the text object’s density settings.
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Choosing a Fill Pattern
When you install Pacesetter Simply Appliqué, a wide variety of
Standard and Carved patterns are installed along with the
software. You can select which Standard or Carved pattern to use
in the Properties box.

To choose the fill pattern:
1
2
3

4
5

Select the Lettering segment.
In the Fill area of the Properties box, in the field labelled Fill
Type, select either Standard or Carved.
Click on the down arrow on the right of the Pattern field to
display a drop-down list of patterns.
You see a list of patterns; the patterns that are displayed
depend on the type of fill you chose in step 2.

From the Pattern list, select a pattern.
Click Apply.
The fill of your text segment is altered accordingly.
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Fill Density Setting
Fill density is the distance between individual lines of embroidery.
Density is measured in millimeters.
Note that the density setting is given in millimeters. Therefore,
larger values correspond to a lower density, while lower values
correspond to a higher density. For more details on stitch density
units, see “Density” in the Glossary.

Use the density setting to adjust your fill to suit the fabric you are
sewing on. For example, fabrics with a very loose weave are less
able to hold a large density of stitches; in cases such as this, you
can lower the density of the fill.
If you are unsure what setting to use, try the standard setting of
0.4. This setting works well almost universally, as long as you
have not exceeded the font’s size recommendations.
In the Fill area, the image beneath the Density setting will change
as you adjust the setting. These are not precise images; rather,
they are intended to provide you with visual cues to what you are
doing as you change the settings.
A general rule is to go for full-fabric coverage, but add extra
stabilizer if you want to support a high-density fill on a lowdensity fabric.

If the letters in the text segment are large (i.e., above the maximum recommended height for the font) it is better to use a fill,
rather than satin stitches, for the lettering. Fill stitches are the
type you would normally find filling an area in an embroidery
design. With Fill stitches, each line across is made up of two or
more individual stitches.
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Carved Fill Properties
In addition to the density and stitch-length settings described
above there are a few extra fill settings that apply only to the
Carved fills. You can adjust these Carved pattern settings in the
Properties box. The settings allow you to change a fill pattern’s
characteristics such as the size and angle of the fill pattern.
The following figures show some different effects you can create
using the Carved Fill settings.

Original (scale at 100%)

Emboss Scale at 50%

To change the Emboss Scale of a Carved pattern:
1
2

Select a Carved fill segment
In the Fill area of the Properties panel, do the following:



3

Click the Emboss Scale box to select this property.
In the Emboss Scale field, enter a percentage value to
adjust the scaling.
Click Apply.

To change the Emboss Angle of a Carved pattern:
1
2

Select a Carved fill segment
In the Fill area of the Properties panel, do the following:



3

Click the Emboss Angle box to select this property.
In the Emboss Angle field, enter a percentage value to
adjust the angle.
Click Apply.
You see your segment altered accordingly.
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Underlay Properties
Underlay stitches are laid down before the visible, or “top”
stitches, to help stabilize stretchy fabrics. They can also help to
tack down wales or naps (on fabrics such as corduroy).
There are a variety of possible underlay types available; the
following image gives a schematic view of how the different types
of underlay are sewn.

Selecting the Underlay Type
You can select underlay types for various types of stitches.
Choose from Contour, Perpendicular, Lattice, Full Lattice,
Parallel, or Zig-Zag. You can combine underlay types to get
maximum coverage.
Note that not all underlay types will be available for text; in
particular, Lattice and Full Lattice underlay will not be available
for text segments.

To select an underlay type:
1
2
3

Select the segment.
In the Properties panel, scroll down to the Underlay area.
Select one or more of the available underlay types.
When you select underlay types, you will be able to see what
your underlay type will look like in the Preview area.
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4
5

Adjust any of the other settings. Refer to the related
procedures for more information.
Click Apply.

Setting the Underlay Density
You can specify the density for underlay stitches.

To set the underlay density:
1
2
3
4
5
6

Select the segment.
In the Properties Panel, scroll down to the Underlay area.
Select one or more of the available underlay types.
In the Density box, enter a density value.
Adjust any of the other settings. Refer to the related
procedures for more information.
Click Apply.

Setting the Underlay Stitch Length
You can specify the stitch length for your underlay stitches. You
can increase or decrease the length according to your underlay
needs.

To specify the underlay stitch length:
1
2
3

Select the segment.
In the Properties Panel, scroll down to the Underlay area.
Select one or more of the available underlay types.
When you select underlay types, you will be able to see what
your underlay type will look like in the Preview area.

4
5
6

In the Stitch Length box, enter the stitch length that you want
for your underlay stitches.
Adjust any of the other settings. Refer to the related
procedures for more information.
Click Apply.
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Changing the Inset Distance
You can change the inset distance. Pacesetter Simply Appliqué
calculates the inset distance (the distance the underlay stitches
are placed from the edge of the top stitching.) Inset distance
changes the amount of underlay coverage. The smaller the inset
distance, the more coverage you have.

To change the inset distance:
1
2
3

Select the segment.
In the Properties panel, scroll down to the Underlay area.
Select one or more of the available underlay types.
When you select underlay types, you will be able to see what
your underlay type will look like in the Preview area.

4

In the Inset box, enter the amount of distance you want.
Enter a zero value if you want to place the underlay directly on
the edge of the segment.

5

Click Apply.

Pull Compensation Settings
Pacesetter Simply Appliqué allows you to adjust the pull
compensation in your design, through the Properties tab. There
are two types of pull compensation, which differ in the way that
the pull compensation is determined.
•

A percentage pull compensation calculates the change made
to the stitches’ width based on their original width.

•

An absolute pull compensation is simply an extra amount of
width which is added to the stitches regardless of their
original length.
When you use percentage pull compensation, you can also
enter a value in the Max range box of the Pull Compensation
area. This value sets an absolute maximum limit on the size of
the pull compensation. If the calculated pull compensation value
goes over this length, the actual stitches that are generated will
be limited to this length.
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To adjust the pull compensation:
1
2

Select the item you want to adjust.
Press ALT + Enter to display the Properties panel, if it is not
already visible.
You see the Properties panel.

3

In the Pull Compensation area of the Properties panel, click
the down arrow to the right of the Type field.
A list of options is displayed.

4

Select one of the following options:



5

None. Makes no adjustments to pull compensation.
Percentage. Enter the percentage in the Value % box and,
if necessary, enter the maximum value of pull
compensation in the Max Range box.
 Absolute. Enter the amount of absolute pull compensation
(in mm) in the Absolute Value box.
Click Apply.
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Index
Numerics
3D tool 15

A
Absolute Pull Compensation 121
Add Appliqué tool 78–79
Add Design tool 15 , 44–46
Align tools 62
Aligning segments 62
Alignment 106
Allowed overlap distance (Remove
overlapped stitches tool) 68
Anchor points 74
Angle, text 88
Appliqué borders 108
Appliqués
Add Appliqué 78–79
Background fabric 51
Creating artwork for ScanNCut
53–56
Properties of 46 –52
Auto-insert color changes 98
Automatic Color Match 24
Autosave 24
Available characters 102

B
Background color 29
Background Color tool 16
Bean stitch 49, 111
Bottom tool (Align) 17, 63

C
Carved Fill patterns 115 , 117
Center tool (Align) 17, 63
Changing background colors 29
Changing font type 101

Changing inset distance 120
Changing patterns 117
Changing Text Direction (Circle
Text) 111
Changing the slant setting 104
Changing thread colors (text) 96
Close Shape tool 18
Closest Point (connection setting)
105
Color Changes, Automatic 98
Color match on loading 24
Color Palette 21 , 70 , 96
Connection type 105
Convert to Outlines 37
Convert to outlines 57
Copying segments 61
Creating new designs 36
Custom Hoop 34

D
Deleting segments 66
Density 119
Density settings 116
Design files, merging 56 –58
Design size 27
Design Window 6 , 36
Design workspace 6 , 28 , 30
Designs, adding 44–46
Display Hoop command 32
Double Run stitch 49, 111
Dragging segments 64
Draw Bar 19, 20
Drawing speed settings 20

E
Edit Shape tool 18, 74 , 76
Edit Tools 13
Editing anchor points 74
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Envelope 87
Export FCM 13, 55
Export Image 13
Export SVG 13, 55

Insert selection 15
Inset distance 120
Inset percentage (Text) 47 , 48,
108, 110

F

L

FCM, exporting as 55
File Tools 15
Fill
Underlay types 118
Fill density 116
Fill patterns
customizing Carved Fill 117
Fill stitches 118
Fit Hoop 16
Flip Horizontal tool 17
Flip Vertical tool 17
Font spacing 103
Font type 101
Furthest Point (connection setting)
105

Left tool (Align) 17, 62
Line Spacing 106
Line Tool 18

M
Machine format 24
Machine Formats 23
Magnifying views 27
Measuring designs 31
Merge Design tool 13
Merging designs 56 –58
Modify Tools 17
Moving Individual Letters 90

N
G

New recipe tool 13
New tool 13
Nudging segments 65

Garment Preview
Background color 72
Dialog 71
Dimensions 73
Grid 25
Grid tool 15
Group/Ungroup command 59
Grouping designs 59

Offset 18
Open Design tool 13
Options 24
Overlapped stitches, removing 67

H

P

Hoop Bracket Location 24 , 42
Hoop Selection 33
Hoop tool 15, 32
Hoops, displaying 32
Horizontal Center tool (Align) 17 , 63

I
Import .FCM 78

O

Page Preview 18
Page Preview Offset 18
Pan Tool 29
Panning 28
Pasting design components 62
Patterns 115
choosing 115
customizing Carved Fill 117
Percentage Pull Compensation 121

Index 125

Placement Offset 50
Preferences
Color match on loading 24
Environment 24
Formats 23
Grid Settings 25
Previewing designs 79
Print 14
Print Preview 14 , 79, 80
Print settings 80
Printing 80
Program Preferences dialog 19
Properties of Appliqué segments
46–52
Properties, text 93
Pull Compensation 120–121
Pull Compensation, absolute 121
Pull Compensation, percentage 121

R
Recipe 23 , 39
Redo tool 14, 21
Reducing views 27
Remove overlapped stitches tool 67
Removing hoops 32
Reset Letter command 106
Reset Text Frame command 88,
106
Resize command 64
Resizing Individual Letters 91
Resizing segments 64
Right tool (Align) 17 , 62
Rotate Left tool 17, 67
Rotate Right tool 17 , 67
Rotating Individual Letters 91
Rotating segments 66
Rotation handles 87

S
Satin stitches 108
Save 43
Save As 43

Save As dialog 13
Save tool 13 , 14
Saving Projects 43
ScanNCut 18 , 53–56
Applying to stitch files 55
Scrollbar slider 19 , 20
Scrollbars 22
Select Hoop 16
Select tool 15 , 58, 59 , 60
Selecting underlay types 118
Setting the Connection type 105
Sew sequence 105
Simulator
Scrollbar slider 19
Single Run stitch 49, 111
Slant setting 104
Slant, text 88
Slow Draw Bar
Scrollbar slider 20
Speed Control 20
Snap to Grid 26
Special Characters 96
Speed Control, drawing 20
Status Line 21
SVG, exporting as 55

T
Tackdown Offset 49, 111
Text Frame, resetting 88 , 106
Text Properties 96
Text properties 93, 106
Fill Density 116
Line spacing 106
Underlay 118–120
Text tool 15
Thread Colors 70
Thread colors 21
changing 71
Title Bar 6
Tools
Edit 13
File 15
Modify 17
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Tools, Draw Bar 19 , 20
Top tool (Align) 17 , 62

U
Underlay 118 –120
Underlay stitch length 119
Underlay types 118
Undo tool 14, 21
Ungrouping designs 59

V
Vertical Center tool (Align) 17, 63
Viewing designs 28 , 65
Views tools 27
Pan 29
Zoom 27
Zoom to actual size 28
Zoom To Fit 28
Zoom to Selection 28

W
Width compensation 105
Worksheet Setting 80
Print Setting 80
Workspace 6
Workspace background color 29

Z
Zoom tool 27

